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Chuong 1. Mé dau

1. M6 hinh huéng doi tuong
MOt sO vi du:
Vidu 1:

M5 hinh: qud dia cu sinh hoc

(Bl

CONSTRUCTION BIUEPRENT




1.1. Lich s phat tri€n

OMT-2 Booch'93 OOSE
James Rumbaugh Grady Booch Ivar Jacobson
OOPSLA 95 UML 0.8
\ Cac phuong phap khac
UML<B UML 1.2
ﬂ = 1998 UML 1.3
Bé nghi chuan OMG 1997 UML 1.0
2001 UML 1.4
Chuian OMG 1997 UML 1.1 2003 UML 1.5
2005 UML2.0 °

1.2. M@t s6 khai niém co ban
Hudng d6i tugng 1a thudt ng(r thong dung hi€n thdi clla nganh cong nghi€p

phan mém. Céc cong ty dang nhanh chéng tim cach dp dung va tich hOp cong nghé
mdi nay vao cic Ung dung cUa ho. That su 12 da phan cac Ung dung hién thoi déu
mang tinh huéng d0i tuong. Nhung hudng dbi tugng cé nghia 13 gi?

LGi ti€p can hudng d6i tuong 1a mOt 10i tu duy vé van dé theo 10i 4nh xa
cédc thanh phan trong bai todn vao cic dOi tuong ngoai dGi thuc. V&i 16i ti€p can
nay, ching ta chia Ung dung thanh cdc thanh phan nhd, g0i 1a cdc d6i tugng, ching
tuong d6i dbc 1ap véi nhau. Sau dé ta c6 thé xay dung Ung dung bang céch chap
cdc d6i tugng dé 1ai véi nhau. Hay nghi dén trd choi x4y 1au dai bang cac mau gob.
Budc dau tién 1a tao hay mua mOt vai loai mau gb cin ban, tUr d6 tao nén céc
khOi xay dung cin ban cla minh. MOt khi di c¢6 cdc khoi xay dung d6, ban c6 thé
chap rép chdng 1ai v6i nhau d€ tao lau dai. Tuong tu nhu vay mot khi di xay
dung m6t s6 d6i tugng cin ban trong thé gidi mdy tinh, ban c6 th€ chap ching
lai vGi nhau d€ tao Ung dung cla minh.
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Xin 18y m6t vi du don gidn: van dé rit tién mat tai nha bing. Cdc “mau
g0“ thanh phan & day s€ 1a 4nh xa cla cdc dOi tugng ngoai dOi thuc nhu tai
khodn, nhan vién, khach hang, ...Va Ung dung s€ dugc sé dugc nhan dién ciing
nhU gidi ddp xoay quanh cdc dOi tugng do.

Phuong phap phan tich va thi€t k€ hudng dOi tugng thuc hi€n theo céc
thuat ng(r va khai niém cUa pham vi linh vUc Ung dung (tUc 1a cUa doanh nghiép
hay don vi ma hé thOng tudng lai cdn phuc vU), nén né tao sU ti€p can tuong Ung
gilta hé thOng va van dé thuc ngoai dOi. Trong vi dU ban xe 6 to, mOi giai doan
phan tich thi€t k€ va thuc hién d€u xoay quanh cédc khdi ni€m nhu khach hang,
nhan vién ban hang, xe 6 to, ... Vi qud trinh phat tri€n phan mém dong thdi 1a qud
trinh cOng tic cUa khich hang/ngudi dung, nha phan tich, nha thi€t k&, nha phat
tri€n, chuyén gia linh vuc, chuyén gia kY thudt,... nén 10i ti€p can nay khi€n cho
viéc giao ti€p gilfa ho v4i nhau dugc dé dang hon.

MOt trong nhitng Uu di€m quan trong bac nhat cla phudng phap phan tich
va thi€t k€ hudng d0i tugng 14 tinh tdi st dung: ban c6 th€ tao cdc thanh phan
(d0i tuong) mOt 1an va dung ching nhi€u 1an sau d6. GiOng nhu viéc ban cé thé
tai st dung cdc khoi xdy dung (hay ban sao cla né ) trong mOt toa l1au dai, mOt
ngdi nha &, mOt con tau vii tru, ban ciing c6 th€ tii st dung cic thanh phan (d0i
tUgng) cin ban trong cic thi€t k€ hudng doi tuong ciing nhu code clla mOt hé
thOng k€ todn, hé thOng ki€m k&, hodc mOt hé thOng dat hang.

Vi cdc d0i tugng da dugc thl nghi€m kY cang trong 1an dung trudc d6, nén
kha niing tai st dung d6i tuong c6 tac dung gidm thi€u 16i va cdc khé khin trong
vi€c bdo tri, gitip ting tOc dO thi€t k€ va phat trién phdn mém.

Phuong phap hudng dbi tugng gidp ching ta x(r 1y cac van dé phlc tap
trong phét tri€n phan mé&m va tao ra cdc thé hé phan mém cé kha niing thich Ung
va bén chac.

1.3. Nguyén tac mo hinh héa va quan Iy dé phire tap

Phuong phap hay phuong thlc (method) 12 mét céch truc ti€p cau tric hod

sU’ suy nghf va hanh dOng cla con nguU0i. Phuong phép cho ngudi st dung biét



phdi 1am gi, 1am nhu th€ ndo, khi ndo va tai sao (muc dich cUa hanh dOng).
Phuong phéap chlfa cdc md hinh (model), cic md hinh dugc diing d€ md ta nhiing
gi st dung cho vi€c truyén dat k&t qud trong qud trinh sU dung phuong phép.
Di€ém khic nhau chinh gilta m6t phuong phap vai mdt ngdén ng(t md hinh hoa
(modeling language) 12 ngdén ng{* md hinh hod khong c6 mot ti€n trinh (process) hay
céc cAu 1€nh (instruction) md ta nhitng cong vi€c nguOi st dung can lam.

MOt mo hinh dugc bi€u dién theo mOt ngdn nglf mé hinh hod. Ngon nglr md
hinh ho4 bao gOm céc ky hi€u — nhiing bi€u tugng dugc ding trong mé hinh — va
mOt tap céc quy tac chi cich s& dung chiing. Céc quy tac nay bao gom:

Syntactic (Cd phdp): cho bi€t hinh dang cic bi€u tugng va cich két
hQp ching trong ngdn ngr.

Semantic (Ng{F nghia): cho biét y nghia cla mOi bi€u tuong, ching
dudc hi€u thé nao khi ndm trong hodc khong nam trong nglt cdnh cla
cdc biéu tugng khic.

Pragmatic: dinh nghia y nghia cUa bi€u tugng d€ sao cho muc dich
cUa md hinh dugc th€ hién va moi ngudi ¢ thé hi€u dugc.

1.4. M hinh huéng d6i tuong vGi chu trinh phat tri€n phan mém

Kinh nghi€m cUa nhi€u nha thi€t k& va phat tri€n cho thdy phét tri€n phan
mém 12 mOt bai toan phlc tap. MOt sO céc 1y do thuGng dugc k& dén:

Nh{ng ngudi phit tri€n phan mém rat khé hi€u cho ding nhiing gi
ngUQi ding can.

Yéu cau cla ngu0i dung thuOng thay d6i trong thOi gian phat trién.

Yéu cdu thuOng dugc miéu td bang vin ban, dai dong, khé hiéu,
nhi€u khi thdm chi mau thudn.

DOi quan phat tri€n phan mém, vOn 13 ngudi "ngoai culc", rat khé
nhan thUc thau ddo cdc mOi quan hé ti€m an va phUc tap can dugc thé
hién chinh x4c trong cac Ung dung 16n.

Kha ning ndm bat cic d{f liéu phlc tap cla con ngudi (tai cing mOt
thOi di€ém) 1a c6 han.



Khé dinh 1ugng chinh x4c hi€u sudt cla thanh phdm va thda min
chinh x4c sU' mong chd tU phia ngU0i dung.

Chon 1ua phan cUng va phan mém thich hgp cho gidi phap 1a mot
trong nh{ng thach thic 18n dGi v&i Designer.

Phan mém ngoai ra can c¢é khd ning thich Ung va mé rbng. Phan mém
dugc thiét k€ tot 1a phdn mém ding ving trudc nhlng bi€n dGi trong moi
truOng, du tU phia cOng dOng ngudi dung hay tU phia cong nghé. Vi du phan
mém di dugc phat tri€n cho mOt nha bing can c6 khd ning tdi st dung cho mot
nha bing khdc v&i rat it stta dGi hodc hoan toan khong can slta dGi. Phan mém
thod min c4c yéu cau d6 dugc coi 1a phan mém c6 kha niing thich Ung.

MOt phdn mém c6 khd ning mé rdng 1a phdn mém dugc thi€t k€ sao cho
dé phit trién theo yéu cau cla ngudi ding ma khong can sa chira nhiéu.

Chinh vi vy, mOt s cic khi€m khuy&t thuOng gdp trong phat tri€n phan
mém 1a:

Hi€u khong diing nhiing gi ngudi ding can

Khoéng thé€ thich Ung cho phit hop v&i nhiing thay d6i vé yéu cau dbi
vGi hé thOng

Cédc Module khong khGp vGi nhau

Phan mém khé bdo tri va nang cdp, mG rOng

Phat hién tré cic 16 h6ng cla du 4n

Chat lugng phan mém kém

Hiéu ning cUa phan mém thap

Céc thanh vién trong nhém khong bi€t dugc ai di thay dbi cai gi, khi
ndo, & dau, tai sao phai thay doi.

2. Ngon nglt mé hinh héa théng nhat
2.1. Ngén nglt mo hinh héa thdng nhat
Ngon ng(f mo hinh héa thOng nhat (Unifield Modeling Language — UML) 1a
mOt ngdn nglt d€ bi€u dién mo hinh theo hudng doi tugng vGi chll dich la:
M0 hinh ho4 c4c hé thOng st dung cac khdi niém hudng doi tugng.



Thi€t 1ap mOt k&t ndi tU nhan thlc cla con ngUOi dé€n cic su ki€n
can mo hinh hod.

Gidi quyét van dé vé mUc do0 thlra k€ trong cic hé thdng phUc tap,
c6 nhiéu rang budc khac nhau.

Tao mOt ngén nglt mo6 hinh hod c6 thé s dung dugc bdi ngudi va
may.

Vi phit tri€n phan mém 1a mOt bai todn khd, nén cé 1€ trudc hét ta can
di€m qua mOt s cic cong vi€c cin ban cla qué trinh nay. ThuOng ngUdi ta hay
tap hop ching theo ti€n trinh thdi gian mOt cich tuong ddi, xoay quanh chu trinh
cla mOt phan mém, dan tdi két qUa khai niém Chu Trinh Phét Tri€én Phan Mém
(Software Development Life Cycle - SDLC) nhu sau:

Chu Trinh Phét Tri€n Phan Mém 13 mOt chubi cdc hoat dOng cla nha phan
tich (Analyst), nha thi€t k€ (Designer), ngudi phiat tri€n (Developer) va ngUdi ding
(User) d€ phat tri€n va thuc hién mOt hé thOng thong tin. Nhitng hoat dOng nay
duoc thuc hién trong nhiu giai doan khac nhau.

Nha phan tich (Analyst): 12 ngudi nghién cUu yéu cau cUa khich
hang/ngudi dung d€ dinh nghia mOt pham vi bai to4n, nhan dang nhu
cau cla mOt tG chlc, x4c dinh xem nhan 1Uc, phuGng phip va cong
nghé& mdy tinh c6 th€ 1am sao d€ cdi thi€n mOt c4ch tOt nhat cong tic
cla tG chlc nay.

Nha thi€t k€ (Designer): thi€t k€ hé thOng theo hudng cdu tric cla
database, screens, forms va reports — quy€t dinh cic yéu cdu vé€ phan
cUng va phdn mém cho hé thOng can dudgc phat trién.

Chuyén gia linh vuc (Domain Experts): 12 nh{tng ngu0i hi€u thuc chat
van dé cling tat ca nhling su phUc tap cla hé thdng can tin hoc ho4.
Ho khong nhat thi€t phdi 14 nha 1ap trinh, nhung ho c6 th€ gitip nha
1ap trinh hi€u yéu cau dat ra d6i vGi hé thOng can phat tri€n. Qua
trinh phat trién phan mém sé c6 rat nhi€u thudn 10i n€u ddi ngii 1am
phan mém c6 dugc su trg gidp cla ho.



Lap trinh vién (Programmer): 1a nhing ngU0i dUa trén c4c phan tich va
thi€t k€ d€ viét chuong trinh (coding) cho hé thOng bang ngdn nglr
1ap trinh di dugc thOng nhat.
Ngudi dung (User): 1a d6i tugng phuc vu cla hé thOng can dugc
phét trién.

P& cho 15 hon, xin 13y vi du vé mOt van dé don gidn sau:

NgU0i binh thuOng chiing ta khi nhin mOt chi€c xe 6 t6 thudng s€& cé mOt

bUc tranh tU bén ngoai nhU sau:
Van dé

Hinh: Nhin van dé 6 t6 cUa ngudi binh thudng

Chuyén gia linh vuc s€ gitip nha phan tich "trinh bay 1ai" van dé nhu sau:
M hinh

E

Thén =e Banh ze Béng co

Cixa

Hinh: Nhin van dé 6 t6 cUa chuyén gia phan tich
Chinh vi sU trQ gitp cUa chuyén gia linh vuc c6 th€ déng vai trdo rat quan
trong nén trong nhiing giai doan dau cla qu4 trinh phét tri€n phan mém, két qua
phan tich nén dugc th€ hién sao cho dé hi€u doi vbi cic chuyén gia linh vuc. Day
cting 12 mot trong rat nhi€u 1y do khi€n cho phuong phap hudng dbi tuong dugc
nhi€u ngudi hudng Ung.
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2.2. UML va Ung dung trong phan tich thi€t k€ hudng doi tuong
Phian tich hudng doi tuong (Object Oriented Analysis - OOA):

L2 giai doan phét tri€n mOt mo6 hinh chinh x4dc va sic tich cUa van dé, c6
thanh phan 1a c4c dOi tugng va khai niém ddi thuc, dé hi€u d6i v&i ngudi s
dung.

Trong giai doan OOA, van dé dudc trinh bay bang cédc thudt nglt tuong
Ung vGi cdc dOi tugng c6 thuc. Thém vao d6, hé thOng can phdi dugc dinh nghia
sao cho ngUdi khdng chuyén Tin hoc c6 thé dé dang hi€u dugc.

Dua trén mOt van d€ cé san, nha phén tich cdn 4nh xa cdc d6i tugng hay
thuc thé cé thuc nhu khach hang, 6 t6, ngudi ban hang, ... vao thiét k& dé tao ra
dugc ban thi€t k€ gan can vdi tinh hudng thuc. Mo hinh thiét k€ sé chlra cic
thuc th€ trong mOt van dé c6 thuc va gilt nguyén cdc mau hinh vé cdu triic, quan
hé ciing nhu hanh vi cUa ching. N6i mOt céch khdc, sU dung phuong phip hudng
d0i tuong chiing ta c6 th€ mo hinh héa cic thuc th€ thubc mot van dé cé thuc ma
van gilt dugc cdu triic, quan hé ciing nhu hanh vi cla chiing.

PGi v6i vi du mOt phong béan 6 to, giai doan OOA sé nhan biét dugc cic
thuc thé nhu:

Khéch hang
Ngu0i ban hang
Phi€u dat hang
Phi€u (ho4 don) thanh todn
Xe 0 to
Tuong tic va quan hé gilra cic d0i tugng trén 1a:
Ngu0i ban hang dan khach hang tham quan phong trung bay xe.
Khéch hang chon mOt chiéc xe
Khach hang viét phi€u dat xe
Khéch hang tra tién xe
Xe & td dugc giao dén cho khach hang

DPGi v3i vi du nha bing 1&, giai doan OOA s& nhan bi€t dugc céc thuc thé

nhu:
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Loai tai khodn: ATM (rit ti€n tu dOng), Savings (ti€t ki€m), Current
(binh thuOng), Fixed (dau tu),...

Khach hang

Nhan vién

Phong may tinh.

Tuong tac va quan hé gilta cic d0i tuong trén:

MOt khach hang m&i m& moOt tai khodn ti€t ki€ém

Chuyé€n tién tU tai khodn ti€t ki€ém sang tai khodn dau tu

Chuyé€n tién tU tai khodn ti€t ki€ém sang tai khodn ATM

Xin chi y 1a & day, nhu di néi, ta chid y d€n cd hai khia canh: thong tin va
cdch hoat dOng cla hé thOng (tUrc 1a nhing gi ¢6 th€ xdy ra vGi nhiing thong tin
d6).

LOi phan tich bang ki€u 4nh xa "d0i thuc” vao mdy tinh nhu thé that su 1a
Uu di€m 16n clia phuong phap hudng doi tugng.

Thi€t ké hudng ddi twong (Object Oriented Design - OOD):

L3 giai doan t6 chlc chuong trinh thanh cdc tdp hgp d6i tuong cOng tic,
moi d6i tuong trong d6 1a thuc th€ clia mot 1Gp. Cac 1Gp 12 thanh vién cla mOt cay
cau tric v&i mOi quan hé thlra k€.

Muc dich cUa giai doan OOD la tao thi€t k€ dua trén k€t qua cUa giai doan
OOA, dua trén nhing quy dinh phi chUc ning, nhiing yéu cau vé& moi trudng,
nh{ing yéu cdu vé kha ning thuc thi,.... OOD tap trung vio vi€c cai thi€n két qud
cla OOA, t0i Uu héa gidi phdp da dugdc cung cap trong khi van ddm bdo thod
min tat cd cdc yéu cau da dudgc xic 1ap.

Trong giai doan OOD, nha thi€t k€ dinh nghia cdc chUc ning, thU tuc
(operations), thuOc tinh (attributes) cing nhu mOi quan hé cla mOt hay nhi€u 16p
(class) va quy€t dinh ching can phai dugc di€u chinh sao cho phit hgp v&i moi
truOng phit tri€n. Py ciing 12 giai doan d€ thi€t k€ ngan hang d{t liéu va 4p dung
cdc kY thudt tiéu chudn hoa.
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Vé cubi giai doan OOD, nha thiét k€ dua ra moOt loat céic biu do (diagram)
khac nhau. C4c bi€u d0 nay c6 th€ dugc chia thanh hai nhém chinh 13 Tinh va
dOng. Céc bi€u do tinh biéu thj cdc 18p va d0i tugng, trong khi bi€u d6 ddng bi€u
thi tuong tdc gilra cdc 18p va phuong thlc hoat dOng chinh x4c cla ching. Cac 16p
d6 sau nay c6 th€ dugc nhém thanh cdc géi (Packages) tUc 1 cdc don vi thanh phan
nhd hon cla Ung dung.

3. Khi quat vé UML
3.1. UML va céc giai doan cUa chu trinh phat tri€n phan mém

Giai doan nghién cltu so'bO:

UML dua ra khdi ni€m Use Case d€ ndam bat cic yéu cau cla khich hang
(ngudi s& dung). UML s dung bi€u d0 Use case (Use Case Diagram) d€ néu bat
mOi quan hé ciing nhU su giao ti€p v&i hé thOng.

Qua phuong phap md hinh héa Use case, cdc tdc nhan (Actor) bén ngoai quan
tam dén hé thOng s& dugc mod hinh héa song song v&i chlc ning ma ho doi hdi tur
phia hé thdng (tUc 1a Use case). Céc tdc nhan va cdc Use case dUQc mo hinh héa
ciing cdc mOi quan hé va dugc miéu ta trong bi€u db Use case clla UML. MOi mdt
Use case dUQc md ta trong tai li€u, va né s& ddc td cic yéu cau cla khich hang:
Anh ta hay chi ta chG doi di€u gi & phia hé thOng ma khong hé d€ y dén viéc
chlc ning nay sé dugc thuc thi ra sao.

Giai doan phan tich:

Giai doan phan tich quan tAm d€n qud trinh trUu tUOng héa dau tién (céc 18p
va cdc dOi tuong) ciing nhU co ch€ hién h{tu trong pham vi van dé. Sau khi nha
phén tich d4 nhan bi€t dugc cic 18p thanh phan cla mo hinh ciing nhu' m6i quan
hé gilra ching v&i nhau, céc 16p cuing cic mOi quan hé d6 s€ dudc miéu td bang
cong cu biu d6 10p (class diagram) clla UML. Su cOng téc gilta cic 16p nham
thuc hién cdc Use case ciing s& dugc miéu td nhd vao cdc md hinh ddng (dynamic
models) clla UML. Trong giai doan phan tich, chi duy nhat c4c 16p c6 tOn tai trong
pham vi van dé (cic khai niém doi thuc) 1a dugc mo hinh héa. Cac 16p kY thudt
dinh nghia chi tiét cing nhU gidi phdp trong hé thdng phan mém, vi du nhu céc
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18p cho giao di€én ngudi dung, cho ngan hang d{ li€u, cho sU giao ti€p, trung hgp,
v.v..., chua phdi 12 mOi quan tim cUa giai doan nay.

Giai doan thiét ké:

Trong giai doan nay, két qud cla giai doan phan tich sé dugc md rOng
thanh mOt gidi phap kY thudt. Cac 16p mdi sé dugc bl sung d€ tao thanh mOt ha
tang cO sG kY thudt: Giao dién ngudi diing, cic chlc ning d€ Iuu tr(f cic dbi
tugng trong ngan hang d{r 1iéu, giao ti€p v&i cic hé thOng khic, giao dién véi cic
thi€t bi ngoai vi va cidc mdy méc khdc trong hé thOng, .... Cac 18p thuOc pham vi
van dé c6 tur giai doan phan tich s& dugc "nhiing" vao ha tang co sd kY thudt nay,
tao ra kha ning thay d6i trong ca hai phuong dién: Pham vi van dé va ha tang co
s&. Giai doan thi€t ké s& dua ra két qud 12 ban dac ta chi ti€t cho giai doan xiy
dung hé thong.

Giai doan xay dung:

Trong giai doan xay dung (giai doan 1ap trinh), c4c 18p cla giai doan thiét
k€ s& dugc bi€n thanh nhiing dong code cu th€ trong mOt ngdn nglt 1ap trinh
hudng doi tuong cu thé (khong nén dung mOt ngdn nglr 1ap trinh hudng chiic
ning!). Phu thuOc vao khd ning cla ngdn nglt dudc s& dung, diy cé th€ 1a mot
cong vi€c kho khin hay dé dang. Khi tao ra cdc mé hinh phan tich va thiét k€ trong
UML, tOt nhat nén cd gang né tranh viéc ngay 1ap tlc bi€n d6i cdc md hinh nay
thanh céc dong code. Trong nhiing giai doan trudc, moé hinh dugc s dung d€ dé
hi€u, dé giao ti€p va tao nén cdu tric cla hé thOng; vi vay, vOi vang dua ra
nh(ng k&t ludn vé viéc viét code c6 th€ s€ thanh mOt trd ngai cho viéc tao ra cic
md hinh chinh x4dc va don gidn. Giai doan xdy dung 12 mOt giai doan riéng biét,
ndi cdc mo hinh dudc chuy€n thanh code.

Thar nghiém:

Nhu d3 trinh bay trong phan Chu Trinh Phat Tri€n Phan Mém, mdt hé
thOng phan mém thudng dugc th nghi€m qua nhi€u giai doan va v4i nhi€u
nhém th(f nghi€ém khac nhau. Cic nhém st dung nhi€u loai bi€u d6 UML khac
nhau 1am nén tdng cho cong viéc clia minh: ThU nghi€m don vi s& dung biéu do
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18p (class diagram) va dac td 10p, th( nghi€m tich hgp thuGng st dung bi€u do
thanh phan (component diagram) va bi€u d6 cOng tic (collaboration diagram), va
giai doan th(f nghi€ém hé thOng s dung bi€u d0 Use case (use case diagram) dé
ddm bdo hé thdng c6 phuong thlc hoat ddng ding nhu da dugc dinh nghia tU ban
dau trong cac bi€u do nay.

3.2. Cac thanh phan cGia UML (Huéng nhin, Bi€u d6, Co ché khung, Thanh phan mé

réng)
Ngon nglt UML bao gdm mOt loat cdc phan t(f d0 hoa (graphic element) c6

th€ dugc k€p hop vGi nhau d€ tao ra cac bi€u do. BGi day 1a mOt ngon nglr, nén
UML ciing ¢6 cdc nguyén tac d€ két hgp cdc phan tUr dé.

MOt s6 nhiing thanh phan chl y€u cla ngoén nglt UML:

HuOng nhin (view): HuGng nhin chi ra nhitng khia canh khéc nhau cUa hé
thOng can phai dugc md hinh héa. MOt hudng nhin khong phai 12 mOt ban v&, ma
12 mOt su trlfu tugng héa bao gdbm mot loat cic bi€u d0 khac nhau. Chi qua viéc
dinh nghia cla mOt loat cdc hudng nhin khdc nhau, mOi huéng nhin chi ra mbt
khia canh riéng biét cUa hé thOng, ngudi ta m&i c6 thé tao dung nén mOt blc
tranh hoan thi€n vé hé thdng. Ciing chinh cidc hudng nhin nay ndi két ngdn nglt
mo hinh héa v&i quy trinh dugc chon cho giai doan phat trién.

Bi€u db (diagram): Bi€u d0 1a cic hinh vé miéu td nli dung trong moOt
hudng nhin. UML c6 tat ca 9 loai bi€u d0 khac nhau dugc st dung trong nhitng
su' k€t hop khac nhau d€ cung cap tat ca cic hudng nhin cla mOt hé thOng.

Phan t mé hinh héa (model element): Cac khdi niém dugc s dung trong
cdc bi€u d0 dudgc goi 1a cic phan t& md hinh, th€ hién cic khai niém hudng doi
tuong quen thuQc. Vi du nhu 18p, doi tuong, thong di€p ciing nhu cdc quan hé
gilta c4c khai niém nay, bao gdm ca lién két, phu thuOc, khéi quit héa. MOt phan
t(* m6 hinh thuOng dugc st dung trong nhi€u bi€u d6 khdc nhau, nhung né ludn
ludn c¢6 chi mOt y nghia v mOt ki hi€u.

CO ché€ chung: CO ché chung cung cdp thém nhiing 10i nhan xét b6 sung,
cdc thong tin ciing nhU cdc quy tac ng(t phdp chung vé mdt phan t& md hinh;
chiing con cung cap thém cic cO ché d€ c6 th€ md rOng ngdn nglt UML cho phu
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hgp vGi mOt phuong phdp xdc dinh (mOt quy trinh, mOt tG chlc hodc mOt nguoi
dung).

Huong nhin (View)

Mo hinh héa mdt hé thOng phlc tap 1a mOt vi€c 1am khé khin. Ly tudng
nhat 1a toan b0 hé thOng dugc miéu td chi trong mOt ban v&, mOt ban vé dinh
nghia mOt cdch rd rang va mach lac toan b0 hé thOng, mOt bdn v€& ngoai ra 1ai con
dé giao ti€p va dé hi€u. Mac du vay, thuOng thi diy 12 chuyén bat khd thi. MOt
ban vé& khong th€é nam bat tat cd céc thong tin can thi€t d€ miéu td mot hé
thOng. MOt hé thOng can phdi dugc miéu td v&i mOt loat cdc khia canh khéc
nhau: V& mat chUc ning (cau tric tinh cUa né cling nhU cic tuong tic dOng), vé
mat phi chUc niing (yéu cdu vé thdi gian, v€ d0 dang tin cdy, vé qud trinh thuc thi,
v.v. va v.v.) cling nhU v€ khia canh t0 chUlrc (t6 chlic 1am vi€c, 4nh xa né vao cic
code module, ...). Vi vay mOt hé thOng thuOng dugc miéu ta trong mOt loat céic
hudng nhin khac nhau, m6i hudng nhin sé th€ hién mot blc dnh dnh xa cUa toan
b0 hé thOng va chi ra mOt khia canh riéng clia hé thOng.

Laogical
Wiew

Compoaonent
e

se Case
ey

Concurrency
Wiew

Deployment
Wi

Hinh - Cic View trong UML
M6i mOt hudng nhin dugc miéu ta trong mOt loat cdc bi€u do, chlra dung

céc thong tin néu bat khia canh ddc biét d6 cla hé thOng. Trong thuc t& khi phan
tich va thi€t k& rat dé xdy ra s tring 13p thong tin, cho nén mot bi€u db trén that
t€ c6 thé 1a thanh phan cla nhi€u hudng nhin khic nhau. Khi nhin hé thOng tUr
nhi€éu hudng nhin khic nhau, tai mOt thoi di€m cé th€ ngudi ta chi tap trung vao
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mOt khia canh cUa hé thOng. MOt bi€u d6 trong mOt hudng nhin cu th€ nio d6
can phdi d0 d0 don gidn d€ tao di€u kién giao ti€p dé dang, d€ dinh lién vGi cdc
bi€u d6 khéc cling nhU céc hu’c’ing nhin khdc, 1am sao cho bUtc tranh toan canh cUa
hé théng dugc miéu ta bang su k&t hop tat ca cdc thong tin tU tat cd cdc hudng
nhin. MOt bi€u do chifa cdc ki hi€u hinh hoc mé ta cdc phan t& md hinh cla hé
thdng. UML c6 tat cd cic hudng nhin sau:

- Hudng nhin Use case (use case view) : ddy la hudng nhin chi ra khia canh
chlc niing cla mOt hé thOng, nhin tU hudng tic nhan bén ngoai.

- Huéng nhin logic (logical view): chi ra chlc ning s& dugc thi€t k& bén
trong hé thOng nhu thé€ nio, qua cic khdi ni€m vé cdu tric tinh ciing nhu Ung xU
dOng cUa hé thOng.

- Hudng nhin thanh phan (component view): chi ra khia canh t& chlc cla
céc thanh phan code.

- Hudng nhin song song (concurrency view): chi ra su tOn tai song song/
tring hop trong hé thdng, hudng dén van dé giao ti€p va ddng bO hoéa trong hé
thOng.

- Hudng nhin trién khai (deployment view): chi ra khia canh trién khai hé
thOng vao cic ki€n tric vat Iy (cic mdy tinh hay trang thi€t bi dugc coi 1a tram
cOng tac).

Khi chOn cong cu dé vé biéu do, hdy chon cdng cU nao tao di€u kién dé
dang chuy&n tU hudng nhin nay sang hudng nhin khdc. Ngoai ra, cho muc dich
quan sat mOt chUc ning s€ dugc thi€t k€ nhu th€ nao, cdng cU nay ciing phai tao
di€u kién dé dang cho ban chuyén sang huGng nhin Use case (d€ xem chlic ning
nay duoc miéu td nhu thé€ nao tU phia tic nhin), hodc chuy&n sang hudng nhin
tri€én khai (d€ xem chUc ning niy s€ dugc phan b ra sao trong cau tric vat 1y -
N6i mOt cach khac 12 né c6 thé ndm trong mdy tinh ndo).

Ngoai cdc hudng nhin k€ trén, nganh cong nghi€p phan mém con s dung
cd cdc hudng nhin khéc, vi du hudng nhin tinh-dOng, huéng nhin logic-vat 1y, quy
trinh nghi€p vu (workflow) va cdc huéng nhin khic. UML khong yéu cau chiing ta
phdi s dung céc huGng nhin nay, nhung day ciing chinh la nhi{tng huéng nhin ma
16



cdc nha thi€t k€ clla UML da nghi t&i, nén c¢6 khd niing nhi€u cong cu s€& dua trén
céc hudng nhin do.

Hudng nhin Use case (Use case View):

Hudng nhin Use case miéu td chUc niing cUa hé thdng s& phdi cung cap do
dugc tic nhan tU bén ngoai mong dgi. Tdc nhan 1a thuc th€ tuong tic v4i hé
thOng; d6 c6 th€ 1a mOt ngudi st dung hodc 12 mOt hé thdng khic. Hudng nhin
Use case 1a hudng nhin danh cho khach hang, nha thi€t k€, nha phat tri€n va ngudi
th(f nghi€m; né dugc miéu ta qua cic bi€u do Use case (use case diagram) va thinh
thodng ciing bao gdm ca cic bi€u db hoat dOng (activity diagram). Cach s dung
hé thOng nhin chung s€ dugc miéu td qua mOt loat cic Use case trong hudng nhin
Use case, n0i mOi mOt Use case 12 mOt 10i miéu ta mang tinh ddc thi cho mt tinh
ning cUa hé thOng (c6 nghia 12 mOt chlic ning dUQc mong dgi).

Hudng nhin Use case mang tinh trung tim, bGi n6é dat ra nOi dung thic day
sU phat tri€n cac hudng nhin khdc. Muc tiéu chung cUa hé thOng 1a cung cap cic
chUc ning miéu td trong hudng nhin nay — ciing v4i mOt vai cdc thuOc tinh mang
tinh phi chlc ning khic — vi th€ hudng nhin nay c¢6 dnh huéng dén tat cd cic
hudng nhin khic. Hudng nhin nay ciing dugc st dung d€ thdm tra (verify) hé
thOng qua vi€c thU nghi€m xem hudng nhin Use case c¢6 diing v&i mong dgi cla
khich hang (HOi: "Dy c6 phdi 1a th( ban muOn") ciing nhU ¢é ding vGi hé thOng
vUa dugc hoan thanh (HAi: "Hé thOng c6 hoat dOng nhu di dac ta?”).

Hudng nhin logic (Logical View):

Hudng nhin logic miéu td phuong thUc ma cic chlic ning cla hé thdng sé
dugc cung cdp. Chl y€u né dudc st dung cho cdc nha thi€t k€ va nha phat trién.
Ngudc lai v6i hudng nhin Use case, huéng nhin logic nhin vao phia bén trong cUa
hé thOng. N6 miéu ta k€ ca cdu tric tinh (10p, dOi tugng, va quan hé) cling nhu
sU' tuong tic dOng s€ xdy ra khi cdc d6i tugng gUi thong di€p cho nhau d€ cung
cap chlic ning di dinh san. HuGng nhin logic dinh nghia cdc thuOc tinh nhu
truOng tOn (persistency) hodc song song (concurrency), ciing nhU cic giao di€n

cting nhU cdu triic n0i tai cUa céac 16p.
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C&u tric tinh dugc miéu ta bang céc bi€u do 1Gp (class diagram) va biu d6
doi tugng (object diagram). Qu4 trinh md hinh héa dOng dugc miéu td trong cic
bi€u d0 trang thdi (state diagram), bi€u dO trinh tu (sequence diagram), bi€u do
tuong tac (collaboration diagram) va biu do hoat dbng (activity diagram).

Hudng nhin thanh phan (Component View):

La mOt 161 miéu ta cUa vi€c thuc thi cic modul cling nhu' sU phu thudc gilra
ching vGi nhau. N6 thuOng dugc st dung cho nha phat trién va thuOng bao gbm
nhi€u bi€u dO thanh phan. Thanh phan & diy 1a cic modul 1€nh thudc nhiéu loai
khéac nhau, s& dugc chi ra trong bi€u do cling v&i cdu tric ciing nhu sU phu thubc
cUa ching. Céc thong tin b0 sung v€ cdc thanh phén, vi du nhu vi tri cla tai
nguyén (trach nhi€m doi v&i mOt thanh phan), hodc céc thdng tin qudn tri khéc, vi
du nhu mOt ban bdo cdo vé ti€n trinh cla cong vi€c ciling ¢ thé dugc bo sung
vao day.

Hudng nhin song song (Concurrency View):

Hubng nhin song song nham t&i su chia hé théng thanh céc qui trinh
(process) va cic bO xU 1y (processor). Khia canh nay, vOn 13 moOt thuQc tinh phi
chlc ning cla hé thOng, cho phép chiing ta st dung mot cach h{tu hi€u cic ngubdn
tai nguyén, thuc thi song song, ciing nhu xU 1y cic su ki€n khong dong b0 tU mdi
truOng. Bén canh viéc chia hé thOng thanh céc ti€u trinh c6 th€ dudgc thuc thi
song song, hudng nhin nay ciing phadi quan tim dén van dé giao ti€p va ddng b0
héa cdc ti€u trinh do.

Hudng nhin song song gianh cho nha phét tri€n va ngudi tich hgp hé thOng,
né bao gbm céc bi€u d6 dOng (trang thai, trinh tU, tuong tic va hoat ddng) cling
cdc bi€u d0 thuc thi (bi€u doO thanh phan va bi€u do tri€n khai).

Hudng nhin tri€n khai (Deployment View):

Cu0i ciing, hudng nhin tri€n khai chi cho chiing ta so d0 tri€n khai vé mat
vat 1y cUa hé thOng, vi du nhu cdc mdy tinh ciing nhU cdc may méc va su lién két
gi(ta ching v&i nhau. Hudng nhin tri€n khai gianh cho cic nha phat tri€n, ngudi
tich hgp ciing nhu ngudi thtr nghiém hé thOng va dugc thé hién bang cdc bi€u d6
tri€n khai. Huéng nhin nay cting bao gdm sU dnh xa cac thanh phan cla hé thOng
18



vao cau tric vat ly; vi du nhu chuong trinh nio hay dOi tUOng nao s& dugc thuc
thi trén mdy tinh nao.

Biéu do (diagram)

Bi€u d0 1a cdc hinh v& bao gdm cic ky hi€u phan t(f md hinh héa dugc sap
x€p d€ minh hoa mOt thanh phan cu th€ hay mot khia canh cu thé€ cla hé thOng.
MOt md hinh hé thOng thuGng c6 nhi€u loai bi€u d0, moOi loai cé nhi€u bi€u do
khic nhau. MOt bi€u d6 1a mOt thanh phan cla mOt hudng nhin cu thé&; va khi
dugc vé ra, n6 thuOng thudng ciing dugc x&p viao mOt hudng nhin. Mat khic,
mOt s6 loai bi€u db c6 th€ 1a thanh phan cla nhi€u hudng nhin khic nhau, tiy
thudc vao ndi dung cla bi€u do.

Phan sau miéu ta cdc khdi niém cin bdn nam dang sau moi loai bi€u do.
Tat ca céc chi ti€t vé bi€u do, ng(t cdnh cla ching, y nghia chinh xdc cUa ching
va sU tuong tic gilra chiing v&i nhau dugc miéu ta chi tiét trong cdc chuOng sau
(md hinh d0i tugng — md hinh d0ng). Céc bi€u d6 18y 1am vi du & day dugc 1ay ra
tUr nhi€u loai hé& thOng khac nhau d€ chi ra nét phong phid va khd ning 4p dung
rOng khap cla ULM.
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Chuong 2: Rational Rose — Cong cu ho tro ngon ngit UML

1. Giao dién doé hoa
Rose hO trg d€ xay dung cic bi€u d6 UML md hinh hod céc 18p, cic thanh

phan va mOi quan hé cla chiing trong hé thdng mdt cch truc quan va thdng nhat.

N6 cho phép mo ta chi ti€t hé thOng bao gbm nhitng céi gi, trao dGi tuOng
tac vOi nhau va hoat dOng nhu thé nao d€ ngU0i phat tri€n hé thOng c6 thé st
dung md hinh nhu k€ hoach chi ti€t cho vi€c xay dung hé thOng.

Rose con ho trg rat tOt trong giao ti€p vGi khach hang va 1am ho so, tai liéu
cho tUng phan tU trong mo hinh.

Rose hO trg cho viéc ki€ém tra tinh ding dan cla md hinh, thuc hién viéc
chuy€n ban thi€t k€ chi ti€t sang ma chuong trinh trong mOt ngdn nglt 18p trinh
lua chon va ngudc 1ai, ma chuong trinh ¢6 thé chuyén trd 1ai yéu cau hé thOng.
Rose hO trg phat sinh ma khung chudng trinh trong nhi€u ngon nglt 1ap trinh khéic
nhau nhu: C++, Java, Visual Basic, Oracle 8, v.v.

Ngoai ra Rose hO trg cho cdc nha phan tich, thi€t k€ va phat tri€n phan
mém:

TG chlc mo6 hinh hé thOng thanh mét hay nhi€u tép, dugc goi 1a don vi
diéu khién dugc. Cho phép phit tri€n song song cic don thé di€u khién dugc cla
mo hinh,

HO tr0 mo hinh dich vu nhié€u tang (ba tang) va md hinh phén tin, cO ché
khéach/chU (Client/Server).

Cho phép sao chép hay chuy€n dich cic t&€p md hinh, cic don vi di€u khién
dugc gilra cac khong gian 1am viéc khac nhau theo cO ch€ “4nh xa dudng dan d0”
(Virtual Path Map),
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Cho phép qudn 1y md hinh va tich hgp vGi nhimng hé thOng di€u khién
chudn, Rose cung cdp khd ning tich hop v&i ClearCase va Microsoft Visual
SourceSafe, v.v.

SU dung céc bl tich hgp mo hinh (Model Integator) dé€ so sanh va két hgp
cdc md hinh, cdc don vi diéu khién dugc v&i nhau.

Ban thin UML khong dinh nghia qué trinh phdt tri€n phdn mém, nhung
UML va Rose ho trg rat hi€u qua trong cd qu trinh xay dung phdn mém.

C6 ba phién ban kh4c nhau cUa Rose :

+ Rose Modeler: cho phép ban tao mo hinh cho hé thOng, nhung khong
hO trg ti€n trinh phét sinh ma hodc thiét k€ kY thudt ddo ngugc.

+ Rose Professional: cho phép phét sinh ma trong mOt ngdén ngt

+ Rose Enterprise: cho phép phét sinh ma cho C++, Java, Ada, Corba, Visual
Basic, Oracle ... MOt md hinh c6 th€ cé cdc thanh phan dugc phét sinh bang céc
ngdn ng( khéc nhau.

Giao dién chinh cUa chuong trinh:

[ Thach tifu 25 (Tithe Bar) ]
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Dong trén cling g0i 1a Thanh tiéu dé (Title Bar) ¢ d6 c6 tén cUa Ung dung
12 Rational Rose. Bén trdi c6 bi€u tugng, 12 hOp Application Control Box cUa Rose,
khi nhap chuOt vio d6 s€ xudt hién.

Control Menu (hinh bén canh), néu Double Click vao biéu tuOng nay
hodc Close hodc Alt+F4, sé két thiic Rose.

Dong th(trhai g0i 1aMenu Bar(Thanh trinhdon) gbm cdc muc
tUr File dén Help va s& dugc kich hoat bang phim Alt néu diing ban phim.

Dong th(rba 1a Standard Toolbar (Thanh cong cuU chudn) ch(fa bi€u tugng
cUa céc 1énh thuOng dung.

NESE +BE @ RO BRDDE e R0

1.1. Trinh duyét
- Diing d€ nhanh chéng di€éu hudng qua md hinh.

-La mOt cdu tric phan cdp maban cé thé€ ding d€ di€u hudng qua md
hinh Rose. M0i th( b0 sung viao mdhinh : cic 10p, cic thanh phan déu
hién thi trong trinh duyét.

- Dung trinh duyét, c6 thé :

BG sung c4c phan t& mé hinh (cic 16p, cc thanh phan, cic s0 do...)
Xem c4c phan t& mo hinh hién c6.

Xem cic mOi lién hé hién c6 gilta cac phan t& mo hinh.

D0i céc phan t& md hinh.

Pat tén 1ai cac phan t md hinh.

BG sung mOt phan t& md hinh viao mOt sa do.

M& mot s do.

+ + + + + + + +

- C6 bbn ki€u xemtrong trinh duyét :Use Case View, Logical
View, Component View va Deployment View.

-Trinh duy@tdugc tGchlc theo ki€u xemhinh cdy. MOi phan
t(f mo hinh c6 th€ ch(ta cac phan t{ khac bén dudi né trong hé& phan cép.
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- Mac dinh, trinh duyét s& xudt hién trong vung bén trdi cla man hinh,
c¢6 th€ di chuy€n dén mOt ndGi khic hodc an trinh duyét.

- P& &n hodc hién trinh duyét can:

+ Nhap phdi chult trong cUa s6 trinh duyét.

+ Chon Hide -> trinh duyét sé &n di.

+ MuOn hién lai, chon View tU thanh trinh don, chon Browser.

1.2. Clta s6 soan thao
C(ra sO soan thdo c6 dang nhu hinh vé:

| R - ¥

a1 o

C(ra sG nay 1a noi tao 1ap, sta d6i vin ban d€ gan vao phan t& md hinh (tic
nhan, UC, quan hé&, thuOc tinh, thao tic, thanh phan, niit).

PE€ tao tai liéu cho mo hinh ta 1am nhU sau: chon phan tU (click chult trén
phan t(), nhdp tai liéu vao clra sO tai liéu. Clra sO tai liéu ciing tat/ma, trdéi nbi
hay bam dinh nhu cUra s Browser.

1.3. Cac cong cu

NS +208 g WO BBEEE Be RO

Biéu

fuong Tén goi Churc niing
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Create New Model Tao mOt tap tin mo hinh mdi

Open Existing Model M@ mOt tap tin md hinh hién c6

Save Model Or Log Luu tap tin md hinh

Cut Cat r0i vin ban ra Clipboard

Copy Chép viin ban ra Clipboard

Paste Dén vin ban tU Clipboard

Print Diagrams ;1; nILlét hay nhi€u s do t& mo6 hinh hién
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Context Sensitive Help

Truy cap tap tin trQ gitp

View Documentation

Xem cUa sO Documentation

Browse Class Diagram

Dinh vi vi m& so d0 Class

Browse Interaction
Diagram

Pinh vi vi m3 sO d0 Sequence hodc
Collaboration

Browse Componet
Diagram

Dinh vi va m& sd d6 Component

Browse state Machine
Diagram

Pinh vi va m@ sO d0 Statechart hodc
Activity

Browse Deployment
Diagram

M@ so d6 Deployment clia md hinh
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Browse Parent M@ so do cha clla mOt sG do.

Browse Previous MG sO d6 vUra xem

Zoom In Ting d0 Zoom

Zoom out Gidm d0 Zoom

Fit In Windows An dinh d0 Zoom d€ nguyén cd so db vlra

lot trong cUra sO

Undo Fit In Window Thoi 1énh Fit In Windows

1.4. Ctta s6 bi€u do6 (Diagram Window)
CUra sO bi€u d6 12 ndi cho phép ta tao 1ap va stra ddi khung nhin d6 hga mo

hinh hién hanh.

MOi bi€u tugng trong bi€u d6 bi€u dién mdt thanh phdn mo hinh héa khic
nhau. CUra sO bi€u d0 xudt hién khi nhap dip chult trén cla sO bi€u do trong clra
s6 Browser.
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1.5. Log
Khi 1am vi€éc trén md hinh Rose, mOt sO thong tin s€ dugc ding vao clra

sO theo d&i. Vi du khi phdt sinh ma, cdc 10i phét sinh s€ dugc ding trong clra
sG theo doi.

2. Cac hudng nhin (View) trong mé hinh Rose

2. 1. Huéng nhin truong hop st dung (User Cases)
Use Case View :bao gOm tat cd cic so db Use Case trong hé thOng.

N6 ciing c6 th€ glp vai sO d0 Sequence va Collaboration. Use Case View 1a mOt
cidch nhin hé thOng dOc 1ap véi thuc thi. N6 tdp trung vao blc tranh tOng
th€ vé ndi dung thuc hién cla hé thOng, khong quan tim dén chi ti€t vé cich
thuc hién né.

Céc thanh phan cUa Use Case View :

Business Actors

Business Workers

Business Use Cases

Business Use Cases Diagrams

Actors

Use Cases

Use Case Diagrams

Activity Diagrams

Sequence Diagrams

Collaboration Diagrams

Packages

2.2. Huéng nhin logic (Logicals)
Logical View :tdp trung vio cdch hé thOng thuc thi cdch Ung xU trong

cdctic vU. N6 cung cdp blc tranh chi ti€t vécic mau hé thOng, mod
ta tinh tuong quan gilfa cdc mau vGi nhau. Logical View bao gbm cic 18p
cu thé can thiét, cic so do Class ...
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Céc thanh phan cUa Logical View:
Classes

Class Diagrams

Sequence Diagrams

Collaboration Diagrams

Statechart Diagrams

Packages

2.3. Hudng nhin thanh phan (Components)
Component View : chlfa dung thong tin v€ cic tap tin thi hanh, cic thu vién

thdi gian chay, c4c thanh phan khéc trong mo hinh ...
Céc thanh phan cla Component View:
Components
Component Diagrams

Packages

2.4. Hudng nhin tri€n khai (Deployments)
Deployment View: lién quan d€n ti€n trinh tri€n khai vat 1y cla hé thOng

Céc thanh phan cUa Deployment View :
Processes

Processors

Connectors

Devices

Deployment Diagrams

3. Lam viéc v@i Rose

3.1. Tao mé hinh
Budc dau tién khi 1am viéc v&i Rose d6 1a tao mOt mo hinh. Cac md hinh

c6 th€ dugc tao tU ddu hodc sirdung moOt framework model hi€n cé (Ia cic

mo hinh cai dat san trong may cho moOt s& ngon ng(f nhu Visual Basic, Java, C++,
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...). Md hinh Rose va tat cd cidc sO dO, cic dO0i tugng, ciac phan t& mo hinh
khéc dugc Iuu trong mOt tap tin don 1€ ¢6 dudi .mdl

— P& tao mOt md hinh :

] =
Chon File -> New tU trinh don, hodc  nhan  ndt  trén  thanh

cong cU chudn.
Néu da cai dat Framework Wizard, danh sich cic cO cdu san cé s xudt

hién (nhu hinh dudi diy). Lua chon cO cdu rOi nhdp nit OK, hodc Cancel néu

khong dung.
Creabe Mew -'“'!tll:li':|_
& ‘-J
A F
Hews IEHisI'nul Racant |
e ® B b 4= |
J2SE12 J2BE13 JISEA Earicad |
®» & & N
o118 ez foll boke Mew Boldh |
Frameeok
v F @
R .
oiedleidat . raliond wified “ES Standad  YLCEATLEZD
ocess
&, =l
I Dioril shovy this dislogin the fulurs Hep
Bt [evaboe Mtk
3.2. Luu mo hinh

GiOng nhu cdc Ung dung khdc, ban nén tao théi quen Iuu tap tin dinh
ky, Rose ciing vay. Nhu'da néu trén, nguyén cd md hinh dugc 1Uu trong mOt
tap tin. Ngoai ra, ¢ th€ 1uu sO theo ddi (Log Window) ra mOt tap tin.

— P& luu mOt md hinh :

+ Chon File -> Save tU thanh trinh don

=

+ Hodcnhd@nnit  trén thanh cdng cuU chudn.
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GiOng nhu c4c Ung dung khdc, nén tao théi quen 1uu tap tin dinh ky, Rose
ciing vay. Nhu da néu trén, nguyén cd mo hinh dugc 1Uu trong mOt tap tin. Ngoai
ra, ban c6 thé€ 1uu s6 theo ddi (Log Window) ra mOt tap tin.

— D€ luu mOt md hinh :

+ Chon File -> Save tU thanh trinh don

=

+ Hodcnhdnnidt  trén thanh cong cuU chudn.
P& 1uu sO theo doi :

+ Lua chon clra sO theo doi.

+ Chon File -> Save Log As tU thanh trinh don.
+ Nhap tén tap tin cUa sO theo doi.

Hoac :

+ Lua chon clra sO theo doi.

=
+ Nhan niit trén thanh cong cU chudn.

+ Nhap tén tap tin cUa sO theo doi.
3.3. Exporting va Importing mo6 hinh

— MOt trong nhing 10i ich chinh cla huéng doi tugng 13 kha ning ding
lai. Khd niing dung 1ai c¢6 th€ 4p dung khong nhlng cho mi macon cho céc
mo hinh. PE van dung day d0 kha ning dung 1ai, Rose hO trg phuong phdp
xudt (nhdp) cdc md hinh va cdc phan tcla md hinh. Ban cé thé xuat mot
mo hinh hodc m6t phan cla md hinh va nhdp né vao cidc md hinh khic.

— P& nhap mOt md hinh, géi hodc 16p :

+ Chon File -> Import Model tU thanh trinh don.

+ Chon tap tin d€ nhap. Céc ki€u tap tin dugc phép nhap bao gOm : model
(.mdl), petal (.prl), category (.cat), subsystem (.sub).

— PE& xudt mOt mé hinh :

+ Chon File -> Export Model tU thanh trinh don.

+ Nhap tén cla tap tin d€ xuat.

— P& xuat mOt géi cac 10p :
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Chon géi d€ xudt tU mOt s d6 Class.

+

+ Chon File -> Export <Packages> tU thanh trinh don.
+ Nhap tén cla tap tin d€ xuat.

— P& xuat mOt 18p :

+ Chon 1&p d€ xuat ti mOt so do Class.

+ Chon File -> Export <Class> tU thanh trinh don.

+ Nhap tén cla tap tin d€ xuat.

3.4. Xuat ban mo hinh 1én Web

3.5. Lam viéc v6i cdc don vi di€u khi€n
3.6. SU dung hop nhat mo6 hinh (Model integrator)
3.7. Lam vi€c vOi hang chi thich

Cho dit mOt ngdén ng(r md hinh héa c6 dugc m& rOng dén bao nhidu ching
n(ra, n6 ciing khong th€ dinh nghia tat cd moi viéc. Nham tao di€u kién b0 sung
thém cho m&t md hinh nhitng thong tin khong thé dugc thé hién bang phan t& mo
hinh, UML cung cdp kha ning kém theo 10i ghi chd. M6t 18i ghi chi c6 thé dugc
d€ bat ky noi ndo trong bat ky bi€u d0 nao, va n6 c6 th€ chla bat ky loai thong
tin ndo. Dang thong tin clia ban than né 1a chubi ky tU (string), khong dugc UML
dién gidi. LOi ghi chi thudng di kém theo mOt sO cic phan t(f md hinh trong bi€u
d0, dugc nbi bang mOt dudng chdm cham, chi ra phan t& md hinh nio dudc chi
ti€t héa hodc dugc gidi thich.

MOt 10i ghi chi thuGng ch(ra 10i nhan xét hodc céc cau hdi cUa nha tao md
hinh, vi du 10i nhac nhd cén phdi x(r Iy van dé nao dé trong thdi gian sau nay. LOi
ghi chi ciing c6 th€ chlfa cdc thdng tin dang khudn mau (stereotype).

Stock Ontion

TheoryPrice(r - --------————-———- Using Black &
MarketPrice() achole Fortnula
ExpirePrice()
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Hinh - MOt vi du vé ghi chi

3.8. Lam vié€c v@i goi
Nhém hay con goi 1a g6i (backage), né dung d€ t0 chlc cic 18p c6 chlc

ning chung 1ai v&i nhau.

Ertiti=s

3.9. Thém file va URLs dén Rose

3.10. Thém va x6a bi€u do
DE& tao biu d6 lam theo cic budc sau:

Click chu0t phai 1én bi€u d0 can tao chon New chon Diagram.
Pat tén cho bi€u d6 mbi dudc tao.
DE x6a bi€u d0, click chudt phai 1én bi€u d6 can x6a chon Delete.
3.11. Thié€t 1ap cac tuy chon chung )
Xdc 1ap céc tuy chon nhu font cht, mau sac :
— P0Gi vbi font chir :
+ Trong Rose, ban c6 thé thay d6i font chf cla cac dbi tugng riéng 1€ trén
mOt sO d6, nhd dé cai thién kha ning dé doc clia md hinh. Céc font chlt va c&
ch{f cting nhU céc thanh phan lién quan ndm trong clta s6 Font nhu hinh dudi day.
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Font: Font shde: Size

[Anal [Regulas [12 ok |
g
Arial Black Italic o o Concel |
) tirial Mamow Bold 11
() Book Antiqua Bold Italic

()} Bookman Old Style

14
T Bookshelf Symbol 7

16

() Century Gothic b 1B B8
Effects - Sample
I Stikeout
[~ Underine AaBbYyZz
Color:
Gk - Script
'Westem -

P& chon moOt font chf nao d6 hay c& chf clla mOt d6i tuong trén mot so do

Lua chon cic d6i tugng mubn diing

Chon Format -> Font tU thanh trinh don. Sau d6 chon font ch{t, kich ¢& ...
muOn ding.

P6i v4i mau sac :

+ Ngoai viéc thay d0i cac font ch(f, ciing c6 th€ thay dGi mau sdc riéng 1&
cho cdc d0i tugng. D€ thay d6i mau sac duOng ké va mau t6 cla mOt d6i tuong
dung c(ra sG Color.

+ D& thay mau dudng ké cla doi tuong :

Lua chon doi tugng muln thay doi
Chon Format -> Line Color tU thanh trinh don
Chon mau dudng ké muln diing
+ D€ thay d6i mau td cUa doi tuong :
Lua chon doi tugng muln thay doi
Chon Format -> Fill Color tU thanh trinh don

Chon mau té6 muOn dung.
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Chuong 3. Use Cases va Actors (Truong hop st dung va céc tic nhan)

1. M6 hinh héa cac truong hop sir dung
1.1. Céac khai ni€m (Actors; User Cases; Ludng su ki€n; Quan hé;...)

Actor (tac nhan)

- La ngudi dung cla hé thOng, mOt tic nhan c6 th€ 1a mOt ngudi ding
thuc hodc cdc hé thOng mdy tinh khic cé vai trd ndo d6 trong hoat ddng cla
hé thong.

- Ky hiéu :

Customer

Use Case :

- Use case ding d€ mo td yéu cau clUa hé thOng mdi vé mat chlic ning,
mOi chlic ning s€ dugc bi€u dién nhu'mOt hodc nhi€u use case .DPay la
thanh phdn cG bdn cla bi€u dO use case. Cdc use case dugc biu dién bdi céc
hinh elip. Tén cic use case th€ hi€én mdt chlic ning xdc dinh cUa hé thOng.

- Ky hiéu :

-

Muon Sach

Relationships (MOi quan hé):

- La cdc mOi quan hé gilta tdc nhan v&i tic nhan, tic nhan vGi Use Case
va Use Case v0i Use Case:

+ include: Use Case nay sU dung lai chUc ning cUa Use Case kia.

+ extend: Use Case nay m3 rOng tUf use case kia bang cach thém vio mOt

chlc niing cu thé.
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+ Generalization: Use Case nay dugc k€ thira cdc chUc ning tU Use Case
kia.
- Ky hiéu :

s=includes= soextendsx

1.2. Phan tich cic truOng hop sU dung

1.3. Bi€u do User Case
Bi€u d0 Use case (Use Case Diagram):

MOt bi€u d6 Use case chi ra mOt sO 1uOng céc tic nhan ngoai cdnh va moi
lién k€t cla ching dBi v&i Use case ma hé thOng cung cap. MOt Use case 13 mOt
101 miéu td cla mdt chlc ning ma hé thOng cung cap. LOi miéu td Use case
thudng 132 mOt vin ban tai li€u, nhung kém theo dé ciing c6 th€ 132 mOt bi€u do
hoat dOng. Cé4c Use case dugc miéu td duy nhat theo hudng nhin tU ngoai vao cla
cdc tic nhan (hanh vi cla hé thOng theo nhu sU mong doi clla ngudi sU dung),
khong miéu ta chlc ning dudc cung cap s€& hoat dOng ndi b0 bén trong hé thOng

ra sao. Cdc Use case dinh nghia c4c yéu cau vé mat chlc ning doi v&i hé thOng..

1 Evmithep ™
/ déng bao higm

Ehach hang : e Newdi ban
bao higm

Thong ké khach hang

%

Bi€u d0 use case cla mOt cong ty bdo hi€m

1.4. Céac vi du va bai tap
Nha bang ABC dua ra cac yéu cau sau:
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MOt khach hang c6 th€ mubn gUli ti€n vao, rit tién ra hodc don gidn ki€m
tra 1ai sO tién trong tai khodn cUa anh ta qua mdy tU dOng rit tién (ATM). Khi dua
ti€én vao hodc rit ti€én ra, can phai ghi ra gidy k€t qua nhiing chuyén dich da thuc
hi€n va trao tO gidy nay cho khach hang.

Quan sit c4c chlc ning cin ban va cic thanh phan tham gia, ta thdy c6 hai
tac nhan dé nhdn ra nhat 1a khach hang va nhan vién thu ngén.

Qua d6, c6 thé nhan dang cac Use Case sau:

GUi tién vao.

Rt tién ra.

Ki€m tra mUc ti€n trong tai khodn

Thuc hién cédc chuyé€n dich ndi b0 hé thdng
In k€t qua céc chuyén dich da thuc hién.

He théng ATM
.-"'r' .——*—"""——\_\\
Gir ) {f Th'lj' C >
nen ‘ hién 3
<< A otor> > t _fa'.ut ) !
Khach | | ‘. Henra = .
han B =gl o5 4 << b ctor>s
- _-_"“‘—-—L,_ In ket L | ATM
qué A

Klem
mu'c tlEﬂ

Hinh— Cdc Use case trong hé thbng ATM

Use Case gUi ti€n vio va rit tién ra phu thudc vao Use Case thuc hién céic
chuyén dich trong n6i bd hé thOng, viéc thuc hién nay vé€ phan né lai phu thudc
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vao chlc ning in ra cdc cdng viéc da dudgc thuc hién. Kiém tra mUc tién trong tai
khodn 12 mOt Use Case dOc lap, khong phu thuQc vao cdc Use Case khdc.
Bai tap:
Bai 1. MOt tdc nhan (Actor) trong mOt Use Case ludn 1a mOt con nguOi
Bai 2. Hé thOng khic ciing c6 th€ déng vai trod tic nhan trong mOt Use Case?
Bai 3. MOi hé th6ng chi c6 mOt Use Case?
Bai 4. Bi€u d0 Use case md ta chUc ning hé thOng?

2. M6 hinh tuong tac
2.1. Bi€u d6 tuong tic

2.2. Bi€u d6 tuan tu
Bi€u d0 tudn tu th€ hién mOt chuli cic su ki€n, hanh vi cla doOi tuong

theo mOt trinh tU thdi gian. N6 dugc s& dung d€ mo ta dong thong di€p dugc gUi
di va va cdc dOi tugng phOi hgp nhén va xUr 1y d€ trd vé két qud ma theo yéu cau
ma thong di€p gUi dén.
Bi€u d0 tuan tu thong thudng dugdc st dung nhu mOt mo hinh gidi thich
cho kich ban usecase.
Bi€u d0 tudn tu th€ hién rat rd d0i tugng nio tuong tic v4i dOi tugng nao
va thong diép 1a gi.
Khi doc mOt bi€u do tuadn tu ta doc tU trdi qua phai va tU trén xuGng dudi.
Céc ky hiéu va quy tac s dung:
Thanh phan tham gia vao bi€u d6 tudn tu c6 th€ 1a Actor, cdc Object va mOt
sO thanh phan sau:
Q @ Boundary (View): La mOt khu6n
—, Boundary 16p d€ mOt hinh mot vai danh gidi Contral
: ' hé thOng, dién hinh ta c6 thé thay :
Boundalry la giao dién chuong trinh. N6 th€ hién cic tuong tic gilta ngiréi dung
vGi hé thOng & mic dO giao di€n man hinh. N6 thuOng dugc sUt dung trong bi€u
do6 tudn tu va nhin nhan dudi md hinh MVC.
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Entity (Model): La m&t kho (Store) dé thu thap thong tin va knowledge trong
hé thdng va dugc 4p dung trong MVC.

Controller: La mOt khuon 18p d€ thé€ hién céc control, quan 1y cdc thuc thé.
Control dugc tG chlic va schedule cho cic tuong tic khac nhau v&i cic thanh phan
khac nhau.

Lifelines: Thé& hi€n su tOn tai cUa dbi tugng theo thdi gian (thOi gian sOng
cUa d6i tugng). Trong UML né dudc bi€u di€én bdi dugc dudng nét roi dlng.

Activations: Th€ hién thdi gian, chu trinh sOng cUa d6i tugng khi thuc hién
mOt service nao dé (thdi gian ma service d6 con tOn tai). Trong UML né dugc biéu
dién bang mot hinh ch{f nhét hep, dimg.

Message: MOt object gli mOt thong di€p d€n mOt object khic nhO thuc hi€én
mOt service nao d6 ma né khong cé. Khi gli mOt message c6 th€ cé tham sO kem

theo va d6 1a knowledge (data) cUa object gUi.

Message (Call, Procedure): goi mOt phuong thlc cu th€ cla object dich.

Self message: Self message 1a tU' g0i mOt phuong thUc ngay tai trong 18p dé.

Return message: La message k€t qud trd vé sau khi di thuc hién mOt
message gUi

Destroy: K&t thiic chu trinh sOng cUa d0i tugng thi ta phdi huy dbi tugng.

Bi€u d0 sequence(diagrams):
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A class operation message

with parameter value

instance

3

a: Typeh b: TypeB

T

|

|

i
message(parameter_valie)

return_value

focus of control

timeline b returns control to

2.3. Bi€u d6 cdng tac
MOt bi€u d6 cOng tac miéu td tuong tic gilta cac dOi tUgng ciing giOng nhu

bi€u d0 tudn tu, nhung né tap trung truGc hét vao cac su kién, tlc 1a tdp trung
chU y€u vio su tuong tic gilra cdc d6i tuong.

Trong mOt bi€u d6 cOng tic, cic dOi tugng dudc bi€u dién bang ki hiéu
16p. Th{r tu trong bi€u d6 cOng tic dugc th€ hién bang cich dinh sO céc thong
diép. Ky thuat danh sO duoc coi 1a hoi c6 phan khé hi€u hon so véi k¥ thudt mii
tén s dung trong bi€u do tuan tu. Nhung Uu di€m cla bi€u dO cOng tac 14 né c6
th€ chi ra cdc chi tiét vé cac 1énh goi ham (th( tuc), yéu t6 dugc né tranh trong
biéu d0 tudn tu.

Bi€u d0 sau day 1a mOt vi du cho mOt bi€u dod cOng tac, dugc chudn bi ciing
cho mOt canh kich rit tién mat nhu trong bi€u do0 tudn tu cla phan trudc. Hay
quan sit cac th(r tu sO trong bi€u d6. Pau tién thU tuc WithdrawalReq() duQc goi
tUr 16p khich hang. D6 1a 1€nh goi sO 1. Budc ti€p theo trong tudn tu 13 ham
AskForPin(), sO 1.1, dudc goi ti 18p ATM. Thong di€p trong bi€u d6 dugc viét
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dudi dang pin:= AskForPin(), th€ hién rang "gid tri trd v&" cUa ham nay chinh 1a
ma sO ma 18p khach hang s& cung cép.

Hinh cung bén 16p tai khodn biéu thi réng ham ComputeNetBalance() duQc
g0i trong n0i bd 16p tai khodn va né xU Iy cuc bO. ThuOng thi n6 s& 1a mdt thu
tUc riéng (private) cUa 18p.

o _ = =
8| |1. Withdrawal Req() | H =
& L :
=l L1 pn= AckforPING ) 4
o | 1.2 result .=
PinVerfy{pin)
1.3 amount =
_ Askfordamt )
1.4 netamount =
DebitAmount ( amount)
141
CormputeMetBalance( )
l:/
2. displaybalance = ‘\M
CetMetBalance() i

Hinh- MOt bi€u d6 cOng tac cla kich canh rit tién 3 may ATM

2.4. Lam viéc v&i cac doi tuong
2.5. Lam viéc v@i cac thong diép
2.6. Cac vi du va bai tap
3. Hoat dOng cla doi tuong
3.1. Cac khai niém
3.2. Bi€u do hoat déng

Bi€u d6 hoat ddng ndm bat hanh dbng va cic két qua cla ching. Bi€u do
hoat dOng tap trung vao cdng vi€c dugc thuc hién trong khi thuc thi mOt thu tuc
(ham), cdc hoat dOng trong mOt 1an thuc thi mOt truOng hop sU dung hodc trong
mOt d6i tuong. Bi€u d6 hoat dOng 13 mOt bi€n th€ cla bi€u dO trang théi va c6

41



mOt muc tiéu tuong dOi khac, d6 12 ndm bat hanh dOng (coéng viéc va nhiing hoat
dOng phadi dugc thuc hién) ciing nhu két qua cla ching theo su bi€n d0i trang
thai. C4c trang théi trong bi€u d0 hoat dOng (dugc goi 1a cdc trang thdi hanh
dOng) sé chuyén sang giai doan k€ ti€p khi hanh dOng trong trang thai nay da
duoc thuc hién xong (ma khong xdc dinh bat ky mOt su kién nao theo nhu n0i
dung cUa bi€u d0 trang thdi). MOt su’ di€m phan biét khic gilta bi€u d6 hoat dOng
va bi€u d0 trang thai 13 cdc hanh dOng clUa né dugc dinh vi trong
cdc ludng (swimlane). MOt lubng s& gom nhém cic hoat dOng, chi y tGi khai ni€ém
ngUdi chiu trach nhiém cho chiing hodc chiing nam & dau trong mOt t6 chitc. MOt
bi€u d6 hoat dOng 12 mOt phucng phdp b6 sung cho viéc miéu ta tuong tic, di
kém v@i trach nhi€m th€ hién rd cdc hanh dOng xdy ra nhu thé nio, ching lam gi
(thay doi trang thdi dGi tugng), chiing xdy ra khi nio (chubi hanh dbng), va ching
xay ra @ dau (ludng hanh dOng).

Bi€u d0 hoat dbng c6 thé dugc st dung cho nhi€u muc dich khic nhau, vi
du nhu:

- D€ nam bat cong vi€c (hanh ddng) sé phadi dugc thuc thi khi mOt thu tuc
dugc thuc hién. Pay 1a tdc dung thuOng gdp nhat va quan trong nhat cla bi€u do
hoat dOng.

- D€ ndm bat cong viéc ndi b trong mOt dOi tugng.

- D€ chi ra mOt nhém hanh ddng lién quan c6 thé dugc thuc thi ra sao, va
ching s& dnh hudng dén nhiing d6i tuong nam xung quanh ching nhu th€ nao.

- P& chi ra mOt trudng hop s dung c6 thé dugc thuc thé héa nhu thé nao,
theo khai ni€m hanh d0ng va cic sU bién doi trang thai cla doi tuong.

- P& chi ra mOt doanh nghi€p hoat dOng nhu th€ nio theo cdc khai niém
cong nhan (tic nhan), qui trinh nghiép vu (workflow), hodc t0 chlc va dbi tuong
(c4c khia canh vat 1y ciing nhU tri thlc dugc sU dung trong doanh nghiép).

Bi€u d0 hoat ddng c6 th€ dudc coi 1a mOt loai Flow chart. Di€m khac biét
12 Flow Chart binh thuGng ra chi dugc dp dung dbi vGi cic qui trinh tudn tu, bi€u
do hoat ddng c6 thé x(r 1y cd céc cdc qui trinh song song.

Hanh dOng va su thay d0i trang thai
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MOt hanh dOng dugc thuc hién d€ sdn sinh ra mOt két qud. Viéc thuc thi
cUa thU tuc c6 th€ dugc miéu td dudi dang moOt tdp hop cla cac hanh dOng lién
quan, sau nay ching s€ dugc chuyén thanh cdc dong code that su. Theo nhu dinh
nghia & phan trudc, mot bi€u d6 hoat dOng chi ra cic hanh dOng cling mOi quan
hé gilra chiing va c6 th€é c6 mOt di€ém bat ddu va mOt di€ém két thic. Bi€u do
hoat dOng s dung ciing cung nhitng ky hi€u nhu trong bi€u d6 trang thdi binh
thuOng.

‘ S
\
CustomerWindow. Print Mesizﬂg‘:Bux i Create
® AllCustomers() “Prirting” ori | Sl
_  fcreen |
xi Send
'(i \ Eemove | posts n::rjpt file
ey MessageBaox | to printer
J Hy

Hinh - Khi mOt nguGi go0i tic vu PrintAllCustomer (trong 18p
CustomerWindow), cdc hanh dOng kh3i dOng. hanh dOng dau tién 12 hién mOt hOp
thong bdo 1én man hinh; hanh ddng th( hai 1a tao mot tap tin postscript; hanh dOng
th(r ba 1a gdi file postscript d€n mdy in; va hanh dOng th( tU 1 x6a hdp thong bdo
trén man hinh. C4c hanh ddng dugc chuyén ti€p tu dbng; chiing xady ra ngay khi
hanh d0ng trong giai doan ngudn dugc thuc hién.

Ciéc sU thay dbi c6 thé dugc bdo vé bdi cic di€u kién canh gilt (Guard-
condition), cdc di€u kién nay phdi dugc thda man thi sy thay d6i m&i nd ra. MOt
ky hiéu hinh thoi dugc s& dung d€ th€ hién mOt quyét dinh. Ky hi€u quyét dinh
c6 th€ c6 mOt hodc nhi€u su thay dGi di vao vi mOt hodc nhi€u su thay doi di ra
dugc dan nhin di kém cic di€u ki€n bdo vé. Binh thuOng ra, mOt trong sO cic su
thay dGi di ra bao gi0 ciing dugc thGa min (12 ding).

MOt su thay dGi dugc chia thanh hai hay nhi€u su thay d6i khéc sé& dan dén
cdc hanh dOng xdy ra song song. C4c hanh dOng dugc thuc hién dbng thoi, mac
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dui ching ciing c6 th€ dugc thuc hién 1an 1uot tlng cdi mOt. Yéu t6 quan trong O
day 1a tat cd cdc thay d0i dOng thoi phdi dudc thuc hién truGe khi ching dugc
th6ng nhat 1ai vGi nhau (néu c6). MOt dudng thang nam ngang k& dam (con
duoc goi 1a thanh dOng h0 héa — Synchronisation Bar) chi réng mOt sy thay doi
dugc chia thanh nhi€u nhdnh khic nhau va chi ra mOt su' chia s€ thanh cidc hanh
dOng song song. Ciing dudng thang d6 dugc st dung d€ chi ra su th6ng nhat cic
nhanh.

Ki hi€u UML cho céc thanh phan cin ban cla bi€u d0 hoat dOng:

- Hoat dbng (Activity): 12 mOt qui trinh dugc dinh nghia 16 rang, c6 thé
dugc thuc thi qua mOt ham hodc mOt nhém doi tuong. Hoat ddng dugc thé hién
bang hinh ch{t nhat bo tron canh.

- Thanh dGng b0 héa (Synchronisation bar): chiing cho phép ta m& ra hodc 1a
déng 1ai cdc nhanh chay song song n0i b trong ti€n trinh.

oo l
! oy

Hinh - Thanh d6ng b0 héa
- Piéu kién canh gi(t (Guard Condition): cdc bi€u thlc logic ¢ gid tri hodc

ding hodc sai. Piéu ki€n canh gilt dugc th& hién trong ngodc vudng, vi du:

[Customer existing].

- Piém quyét dinh (Decision Point): dugc si dung d€ chi ra céc su thay doi
kha thi. Ki hiéu 12 hinh thoi.

Hinh sau ddy miéu td mOt doan bi€u do hoat dOng clla miay ATM. Sau khi
thé dugc dua viao mdy, ta thay c6 ba hoat dOng song song:

- X4c nhan thé

- X4c nhan ma sO PIN

- X4c nhan sO ti€én yéu cau dudgc rit

44



Chi khi s dung bi€u d6 hoat ddng, cic hoat dOng song song nhu vay mdi
c6 thé dugc miéu td. MOi mot hoat dOng xdc nhn ban than nd cling da c6 thé 1a

|

|. Inzert AT card ]

mOt qud trinh riéng biét.

! !

{ Validate card J ( Validate PIM ‘ [Va]idate Armount ‘

| |

[all walid] [any one invalid)

.- .
Aslk for request DCusplay
message

- L.

(@)

o

Hinh - Bi€u d0 hoat dOng clla may ATM

3.3. Bi€u do chuyén trang thai

Biéu d6 trang thdi dugc sU dung dé€ biéu dién cic trang thai va su chuyén
ti€p gilta cdc trang thdi cla cic dOi tuong trong moOt 16p x4c dinh. Thong thuGng,
mOi 16p s& c6 mOt bi€u dO trang thdi (trlr 16p tritu tuong 1a 16p khong c6 doi
tuong).

Bi€u d0 trang thdi dugc bi€u dién dudi dang mdy trang thai hitu han véi
cdc trang thai va su chuyén ti€p gilta c4c trang thdi d6. C6 2 dang bi€u do trang
thai:
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Biéu d6 trang th4i cho mOt use case: md ta cdc trang thai va chuyén ti€p
trang thdi cla mo6t d6i tuong thubc mot 1&p nao dé trong hoat dOng clla mOt use
case cU thé.

Bi€u d0 trang thai hé thOng mo ta tat cd céc trang thdi clla mOt dOi tuong
trong toan bO hoat dOng cla cd hé thOng.

T&p ky hi€u UML cho bi€u do trang thai:

- C4c thanh phan trong mOt bi€u do trang thai bao gdm:

+ Trang thai (state): Bén trong cdc trang thdi c¢6 th€é miéu td cic bi€n trang
thdi hodc cdc hanh dOng (action) tuOng Ung vdi trang thai do.

+ Trang thdi con (substate): 12 mOt trang thdi ch(fa bén trong mOt trang thai
khdc. Trang théi c6 nhi€u trang thai con goi 1a trang théi t0 hQp. Vi du trang thai

/ Thuce hién tinh toan \

con nhU hinh sau:

Chura tinh toan ] q
s ™y
Tinh() Thuce hién kiém tra
M iy
.. : Kiém tra la1
Da tinh toan L )
Xong i
Return()

\ Tinh tong } /

Hinh: Bi€u d0 trang thdi c6 trang thdi con

Hinh sau s€ chi ra cdc ki hiéu UML th€ hién trang thdi bat ddu va trang thdi
két thiic, sU kién ciing nhU cic trang thdi clla mOt d0i tugng.
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# ™)
o Object
Start state
(@)
Events S
stop

Céc ky hiéu UML thé€ hién bat dau, két thic, su' kién va trang thai cla mot
doi tuong.

Thwoice

. i ! o
Faying ‘ Paid  |destroyed .f'.‘*-.l
L ) Il‘\‘.-_-.-.__.l

Thvoce

. created .

Tnpaid

oy -

Hinh: Bi€u do trang thdi thuc hién hod don.
MOt trang thai ¢6 th€ c6 ba thanh phan, nhu dudc chi trong hinh sau :
™,
([ Mame
State variables

Activities

“

Hinh: Cdc ngdn Tén, Bién trang thdi va hanh dong

Phan th( nhat chi ra tén cla trang théi, vi du nhU ch0, da dugc trd tién hay
dang chuy@n dOng. Phan th(r hai (khdng bat budc) danh cho cdc bi€n trang théi.
Pay 1a nhitng thudc tinh cla 16p dudc th€ hién qua bi€u db trang théi; nhi€u khi
cdc bi€n tam thoi ciing t& ra rat h{tu dung trong trang théi, vi du nhu céc loai bi€n
dém (counter). Phan th(t ba (khong bat bubce) 1a phan danh cho hoat ddng, noi cic
sU' ki€n va cdc hanh d0ng c6 thé dudgc liét ké. C6 ba loai su' ki€én chudn héa c6
thé dugc su dung cho phan hanh d0ng: entry (di vao), exit (di ra), va do (thuc
hién). Loai su kiéndi vao dugc st dung d€ xdc dinh cdc hanh dOng khdi nhap
trang thi, vi du gin gid tri cho mOt thulc tinh hodc gUi di mOt thong diép. Su
kién di ra c6 th€ dugc st dung d€ xac dinh hanh dOng khi r0i bd trang thai. Su
kién thuc hién dugc s& dung d€ xdc dinh hanh dOng can phadi duoc thuc hién
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trong trang thai, vi du nhu gli mOt thong dié€p, chd, hay tinh todn. Ba loai su kién
chudn nay khong thé dudgc si dung cho cic muc dich khdc.

MOt su bi€n dOi trang thai thuOng c6 mOt su kién di kem véi né, nhung
khong bat bubc. Néu c6 mOt su kién di kem, su thay dOi trang thdi s& dugc thuc
hién khi su kién kia xay ra. MOt hanh dOng loai thuc hién trong trang thdi c6 thé
12 mOt qud trinh dang ti€p dién (vi du chd, di€u khién cdc thU tuc,...) phdi dugc
thuc hién trong khi dOi tugng van G nguyén trong trang thai nay. MOt hanh d0ng
thuc hién c6 thé bi ngdt bdi céc su kién tUr ngodi, c6 nghia 12 mOt su kién kién
gdy nén moOt su bi€n dbi trang thdi c6 th€é ngung ngdt mOt hanh dOng thuc hién
mang tinh n6i b dang ti€p dién.

Trong truOng hgp mOt su bi€n dbi trang thai khong c6 su ki€n di keém thi
trang thdi sé thay ddi khi hanh dOng nbi b0 trong trang thai di dugc thuc hién
xong (hanh dOng ndi b ki€u di vao, di ra, thuc hién hay cdc hanh d0ng do ngudi
st dung dinh nghia). Theo d6, khi tat cd cic hanh dOng thubc trang thai da dugc
thuc hién xong, mOt su thay dbi trang thai s€ tu dOng xdy ra ma khong cén su
kién tU ngoai.

Boot | Btarting OS tarting
. applications ‘
® | do/run bios ’: dofload OF ”

/ \ iy \ applications J

Bi€n d6i trang thai khong c6 su ki€n tUr ngoai. SU thay d0i trang thdi xdy ra
khi cdc hoat dOng trong mOi trang thdi dugc thuc hién xong.

Nhéan bi€t trang thai va su ki€n:

Qua trinh phét hién su ki€n va trang thdi vé& mat ban chat bao gdm vi€c hoi
mOt sO céc cau hdi thich hop:

- MOt d6i tugng c6 thé c6 nhiing trang thai ndo?: Hay 1iét ké ra tat ca
nhitng trang thai ma mot d6i tugng c6 thé€ cé trong vong ddi clia né.

- Nhitng su kién nao c6 th€ xdy ra?: BGi su ki€n gy ra viéc thay dGi trang
thai nén nhan ra cdc su kién 1a mOt budc quan trong d€ nhdn di€n trang théi.
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- Trang thai mGi s€ 1a gi?: Sau khi nhan dién su kién, hay x4c dinh trang
th4i khi su' ki€n nay xdy ra va trang théi sau khi su' ki€n nay xay ra.

- C6 nhing thU tuc nao s€ dugc thuc thi?: Hiy d€ y dén cdc thU tuc dnh
hudng dén trang thdi clla mOt ddi tuong.

- ChuOi tuong tic gilta cc d6i tugng 1a gi?: Tuong tic gilta cic dOi tugng
cting c¢6 th€ dnh huéng dén trang théi cla doi tugng.

- Qui dinh nao s& dugc dp dung cho cdc phan Ung cla cic dOi tuong vGi
nhau?: Céc qui dinh kiém tOa phan Ung d0i v&i mOt su kién sé xac dinh rd hon
cac trang thai.

- Nhitng su ki€n va su’ chuy€n tdi ndo 1a khong th€ xdy ra?: Nhi€u khi c6
mOt sO sU ki€n hodc su thay dbi trang thdi khong th€ xdy ra. Vi du nhu ban mot
chiéc 6 t6 da dugc ban roi.

- C4i gi khi€n cho mOt ddi tugng dugc tao ra?: POi tuong dudgc tao ra dé
trd 10i cho mOt su' kién. Vi du nhu mOt sinh vién ghi danh cho mOt khéa hoc.

- C4i gi khi€n cho mOt d6i tugng bi hlly?: P6i tugng sé bi hlly di khi chiing
khodng dugc can tGi nita. Vi du khi mot sinh vién két thiic mOt khéa hoc.

- C4i gi khi€n cho dOi tugng can phdi dugc tdi phan loai (reclassfied)?:
Nhing loai su' kién nhu' mOt nhan vién dugc ting chlUc thanh nha qudn tri sé
khi€n cho dOng tic tdi phan loai cUa nhan vién d6 dugc thuc hién.

Chuy@&n bi€u do6 tudn tu thanh bi€u do trang thai:

Hiy doi theo mOt chuli céc su kién duQc miéu ta trong bi€u do, chubi nay
phdi mang tinh tiéu bi€u cho cdc tuong tic trong hé thOng. Hiy quan sit cic su
kién dnh hudng dén ddi tuong ma ta dang nghién clru.

Hiy sap x€p céc su kién thanh mOt dudng dan, ddn nhan input (hodc entry)
va output (exit) cho cdc su' kién. Khodng cach gita hai su' kién nay sé€ 1a mOt trang
thai.

Néu cdnh kich c6 th€ dudc nhac di nhac 1ai rat nhi€u 1an (vd giGi han),
hiy n6i dudng dan tir trang théi cubi cing d€n trang thai dau tién.
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Bi€u d0 sau diy chi ra bi€u d0 trang thii cla mot 18p may ATM, dudc
chi€t sudt tUr bi€u d6 tudn tu hodc bi€u db cOng tic da dudgc trinh bay trong cic
phan trudc.

Eequest for .
. Request Withdrawal | Process
=tate Mode
e Informatmn = —
Acgle for mformation " -

(Pin/Withdrawal Received —
Amount) - " " Information
Waiting _— forwarded for
“ processing

Hinh: Chuyén mOt biéu do tudn 1 sang biéu do trang thdi

Tron 1an cic canh kich khac vao trong bi€u do trang thai:

MOt khi bi€u do trang thii cho mOt dodi tugng di san sang, ching ta can
phai trOn nhiing chubi su kién c6 dnh hudng dén doi tuong nay vao trong bi€u
do trang thdi. Pi€u niy c6 nghia 12 ching ta can phdi quan sit cdc hiéu Ung gidn
ti€p cla cic sU kién khic doi vGi d6i tuong dang 1a chl dé chinh cla bi€u do
trang thai. DAy 14 viéc quan trong, bdi cic ddi tugng trong mOt hé thOng tuong
tac v&i nhau va vi cic d6i tugng khéc ciing ¢6 kha ning giy nén su ki€n cho mOt
d0i tugng dinh trudc, nén 16i Ung xU ndy ciing can phdi dudc th€ hién trong bi€u
do trang thi.

Di€m bat dau cho cong viéc nay la:

- An dinh mOt di€m bat dau chung cho tat ca céc chudi sy kién b8 sung.

- X4c dinh di€m noi cic Ung x( bat dau khac biét vdi nhitng Ung xU da
dugc md hinh héa trong bi€u d6 trang thai.

BO sung thém su cic bi€n d6i mdi tU trang thdi ndy, trong tu cidch moOt
dudng dan thay thé. Can d€ y dén nhitng duOng dan cé vé ngoai dOng nhat
nhUng that ra c¢6 khac bi€t trong mOt tinh huGng nhat dinh nao dé.

Hay chid y dén céc su ki€n xdy ra trong nhitng tinh huéng bat tién. Mobi su
ki€n do khach hang hay ngu0i s& dung giy nén déu c6 thé€ sa vao trang thdi cla
cdc su kién bat tién. Hé thOng khong ndm quyén di€u khi€n d6i vGi ngudi sUt
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dung va ngudi st dung c6 th€ quyét dinh d€ 1am ndy ra mOt su kién tai moOt thoi
di€ém tién 10i d6i v&i anh ta. Vi du nhu khach hang c6 thé quyét dinh két thic
trudc kY han mot tai khodn dau tu.

MOt truOng hgp khic cling can phdi duge xUr 1y 1a su ki€n do ngudi s
dung giy nén khong thé xdy ra. C6 moOt loat cac ly do (ngudi st dung thi€u tap
trung, buOn ndn, 10 ding...) khi€n cho su kién loai nay khong xdy ra. Ca truOng
hgp nay ciing phdi dugc x(r 1y thau ddo. Vi du mOt khich hang that bai trong viéc
bdo cho nha bing bi€t nhiing ménh 1&nh cla anh ta vé ky han cUa tai khodn, mOt
tam séc dugc viét ra nhung 1ai khong c6 kha ning gidi tda mUc ti€n can thiét.

Nhin theo phuong dién céc bi€u d0 trang thdi nhu 1a mOt thanh phan cla
mo hinh dOng, can chid y nhiing di€m sau:

- Bi€u d0 trang thdi chi cdn dugc tao dung nén cho cic 18p dOi tugng c6
Ung xU dOng quan trong.

- Hay thdm tra bi€u d0 trang thdi theo khia canh tinh nhat quan d6i véi
nh{ng su kién ding chung d€ cho toan b0 md hinh ddng dugc ding dan.

- Dung cdc truOng hgp st dung d€ ho trg cho qud trinh tao dung bi€u do
trang thai.

- Khi dinh nghia mOt trang thai, hiy chi d€ y d€n nhitng thuOc tinh lién quan.

3.4. Cac vi du va bai tap
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Chuong 4. LOp, géi va quan hé
1. L&p va goi
1.1. Lép va tim ki€m 16p

Lop:

MOt 16p 132 mOt 10i miéu td cla mOt nhém cic dOi tugng cé chung thuc
tinh, chung phuong thUc (Ung xU), chung cdc mOi quan hé v&i cic dbi tugng khac
va chung ng{f nghia (semantic). N6i nhu th€ c6 nghia 16p 12 mOt khuén mau dé€ tao
ra d6i tugng. M6i d6i tuong 1a mdt thuc thé cla mot 1Gp nao dé va mOt dbi
tugng khong th€ 1a k€t qua thuc th€ héa cla nhi€u hon mdt 18p. Ching ta sUt
dung khdi niém 18p d€ ban ludn vé cic hé thOng va d€ phan loai cic dOi tugng
ma chiing ta d3 nhan dang ra trong thé gidi thuc.

MOt 10p tOt s€ nam bat mOt va chi mot su trlfu tuong héa - né phdi c6 mot
chU dé chinh. Vi du, mOt 16p vUra c6 kha niing gilr tat cd cac thong tin vé& mOt sinh
vién va thong tin vé tat cd nhitng 18p hoc ma ngudi sinh vién d6 da trdi qua trong
nhi€u nim trudc khong phai 1a mot 18p tOt, bdi né khong cé chl dé chinh. Lép
ndy can phdi dudc chia ra 1am hai 18p lién quan d€n nhau: 18p sinh vién va 16p lich
s cUa sinh vién.

Tim 16p:

Hau nhu khong c6 mOt cong thlc chung cho viéc phat hi€n ra cic 16p. bi
tim céc 16p 12 mOt cong viéc doi hdi tri sdng tao va can phdi dugc thuc thi véi su
trQ gidp cUa chuyén gia Ung dung. Vi qui trinh phan tich va thi€t k€ mang tinh
vong 18p, nén danh sich cdc 18p s€ thay dOi theo thOi gian. Tép hop ban dau cla
cdc 1Gp tim ra chua chac da 1a tap hop cubi ciing cla cdc 1Gp sau nay s€ dugc thuc
thi va bi€n d6i thanh code. Vi th€, thuOng ngudi ta hay si dung dén khéi niém
cdc 10p Ung cU vién (Candidate Class) d€ miéu td tap hdp nhlmg 18p dau tién
duoc tim ra cho hé thOng.

Nhu di bi€t truOng hgp s dung 14 nhitng 10i miéu td chlc ning cla hé
thOng, con trach nhi€m thuc thi thuGc vé cic ddi tuong cOng tic thuc thi chic
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ning d6. N6i mOt cach khéc, ching ta di tim cdc 10p 1a d€ ti€n tdi tim gidi phap
cung cap nhimg Ung x(r hudng ngoai di dugc x4c dinh trong cic truOng hgp sUr
dung.

C6 nhi€u phuong phéap khic nhau d€ thuc hién cong vi€éc d6. C6 phuong
phap dé€ nghi ti€n hanh phan tich pham vi bai todn, chi ra tat ca cic 18p thuc thé
(thuOc pham vi bai todn) v&i mOi quan hé cla chiing vGi nhau. Sau d6 nha phat
trién s€ phan tich tUng truOng hop s dung va phan bl trach nhiém cho cic 16p
trong md hinh phan tich (analysis model), nhi€u khi s& thay d0i chiing hodc b8
sung thém céac 16p mbi. Cé phuong phap dé nghi nén 18y cic truOng hop st dung
]am nén tang d€ tim céc 16p, 1am sao trong qua trinh phan bG trach nhi€m thi mod
hinh phan tich cUa pham vi bai to4n s€ tUng budc tUng budc dugc thi€t 1ap.

Phan tich pham vi bai todn dé tim 10p:

Qud trinh phan tich pham vi bai todn thudng dugdc bat dau véi cic khai
niém then chOt (Key Abstraction), mOt cdng cu thudng dugc st dung d€ nhan
dién va Ioc ra c4c 18p Ung cU vién (Candidate class).

Khdi niém then chot:

Hiy 18y vi du mét nha bing ABC, di€u dau tién ta nghi t&i 1a gi? Tién! Bén
canh d6, ABC con phdi c¢6 nhiing thuc thé lién quan t&i ti€n nhu sau:

Khach hang

San pham (céc tai khodn dudc coi la cdc sdn phdm clia mOt nha bing)

Luc luong nhan vién

Ban qudn tri nha bing

Phong may tinh trong nha biang

Nh{ng thuc th€ nay dugc goi 1a cdc khdi ni€m then chdt cho nhiing gi ma
nha bing c6 th€ c6. Khai ni€m then chOt hodc mang tinh cdu triic (structural) hodc
mang tinh chUc niing (functional). Thuc th€ mang tinh cdu tric 13 nhing thuc thé
vat ly tuong tic v&i nha bing, vi du khach hang. Thuc th€ mang tinh chlc ning la
nhng chUc ning ma nha biang phadi thyc hién, vi du duy tri mOt tai khodn hodc
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chuyé€n tién tU thi khodn nay sang tai khodn khac. Khai ni€m then chot 1a céc thuc
thé ta d€ y d€n dau tién. Ching rat quan trong vi gitp ta:

Dinh nghia ranh gidi cla van dé

Nhan manh dén cic thuc thé€ c6 lién quan dén thi€t k€ cla hé thOng

Loai bd thuc th€ nam ngoai pham vi hé théng

Céc khai ni€m then chOt thuOng s€ trd thanh cic 16p trong mo hinh phan tich

MOt khai ni€ém then chOt tém Iai 12 mOt 16p hay dbi tugng thudc chuyén
nganh cUa pham vi bai todn. Khi trinh bay v&i ngudi s& dung, ching c6 mOt dnh
xa 1-1 gilta v6i nhiing thuc th€ lién quan tGi nguoi st dung nhu héa don, sec,
gidy dé nghi rit ti€n, sO ti€t ki€ém, thé rit tién tU dOng, nhan vién thu ngin, nhin
vién nha bang, cac phong ban,....

MUc db trUu tugng:

Khi phén tich pham vi bai todn, can chd ¥ rang mUc d0 trliu tugng cla cic
khdi ni€m then chOt 1a rat quan trong, bdi mUc d0 trltu tuong qua cao hay qua
th&p déu rat dé gdy nham 1an.

MUec trlfu tuong qué cao dan t6i nhiing dinh nghia qud khdi quit vé mot
thuc thé, tao nén moOt c4i nhin vi md va thuOng khong nham vao mOt muc tiéu cu
thé€. Vi du trong mOt nha bing, ta khong th€ chon khéi niém then chOt 1a "ngudi",
bGi n6 s€ dan dén 10i miéu td: "MOt ngudi dén nha bang d€ gli ti€én vao, va sO
tién dé dugc mOt ngudi khac ti€p nhan." — trong khi mOt yéu cdu quan trong &
day 1a phdi phan biét gilta nhan vién v&i khach hang vi chlc ning cla ho la khéc
han nhau.

Tuong tu nhu vay, mUc trifu tugng qué thdp ciing dé gay hi€u 1am, boi
nh(ng thong tin qud vun vat chua thich hop véi thoi di€m nay. Vi du nhitng quyét
dinh dang:

Form m@ tai khodn doi hdi tat ca 15 Entry.

Nh(ing d{r liéu trén Form nay déu phdi dugc cin phdi.

Khong c6 nhi€u chO d€ ghi dia chi clia khach hang trén Form.

nén dugc d€ danh cho céc giai doan sau.

Vai di€m can chi ¥ vé khai ni€m then chot:
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Nhimg thuc th€ xudt hién dau tién trong 6c nio ching ta 1a nhlng thuc thé
dé c6 kha ning tré thanh khdi niém then chot cho mOt van dé dinh trudc.

MO6i 14n tim thdy mOt khéi ni€ém then chdt mdi, can xem xét né theo cich
nhin cUa van dé, cé thé hdi céc ciu hoi sau:

Nh(mg chlc ning nao c6 th€ dugc thuc hién d6i vdi thuc thé nay?

Diéu gi khi€n nhitng thuc thé loai nay dugc tao ra?

Néu khong c6 cau trd 10i thich hgp, can phai suy nghi 1ai vé thuc thé dé.

MO6i khéi niém then chOt mdi can phai dugc dat tén cho thich hgp, miéu ta
ding chUc ning cUa kh4i niém.

Nhén dang 10p va doi tuong:

Nam viing khdi niém 16p, ching ta c6 thé tuong doi dé dang tim thdy cic
16p va d6i tuong trong pham vi van dé. MOt nguyén tac thd sd thudng dugc dp
dung 12 danh tU trong céc 10i phat bi€u bai todn thudng la cic Ung cU vién dé
chuy&n thanh 18p va doi tugng.

MOt sO gdi y thuc té cho viéc tim 18p trong pham vi van dé:

Budc dau tién 12 can phai tap trung nghién clu ky:

Céc danh tU trong nh{mg 10i phat bi€u bai todn

Kién thlc chuyén nganh thuc pham vi bai toan

C4c TruOng hop s dung

Vi du trong 10i phat bi€u "C6 moOt sO tai khodn mang 1ai tién 14i", ta thdy c6
hai danh tU 1 tai khodn va tién 14i. Ching c6 th€ 1a c4c 18p tiém niing cho mo hinh
nha bing 1€.

Th hai, chiing ta c@n chi y dén ciac nhém vat thé trong hé thOng hién thoi
nhu:

Céc thuc th€ vat 1y clia hé thOng: nhimg vat thé tuong tac v6i hé thOng, vi
du khach hang.

Céc vat thé hitu hinh: cdc vat th€ vat 1y ma ta c¢6 th€ nhin va sO thdy. Vi du
nhU cong cU giao thong, sich v, mOt con ngudi, mOt ngdi nha,.... Trong mOt nha
biang ABC, d6 c6 th€ 1a tap sec, phi€u dé€ nghi rit ti€n, sO ti€t kiém, cdc loai Form
can thiét.
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Céc su' kién (Events): MOt chi€c xe bi hOng, mOt cdi clra dugc md ra. Trong
mOt nha bing 13 sU ddo han mOt tai khodn dau tu, hi€n tugng rit qua nhi€u tién
mat trong mOt tai khodn binh thuGng.

Céc vai tro (Role): Vi du nhu me, khich hang, ngu0i bdn hang, .... Trong
mOt nha bdng, vai tro co thé€ 1a nhan vién, nha quén tri, khach hang,...

Cic su tuong tic (Interactions): Vi du viéc ban hang 12 mOt chubi tuong tic
bao gbm khach hang, ngui ban hang va sdn pham. Trong mOt nha bing, viéc mé
mOt tai khodn m&i s€ yéu cau mOt chuli tuong tic gilta nhan vién va khdch hang.

Vi trf (Location): MOt d0 vat nao dé hodc mOt ngudi nao d6 dugc gan cho
mOt vj tri nao d6. Vi du: Otd doi vGi nha d€ xe. Trong mOt nha bing ta c¢6 thé thay
nhan vién thu ngan ludn dlng & clra sG cla minh.

Pon vi t6 chlc (Organisation Unit): Vi du cdc phong ban, phong trung bay
sdn pham, cic bd phan. Trong mOt nha bing c6 th€ c6 bO phan tai khodn binh
thuOng, b0 phan tai khodn ti€t ki€m, b0 phan tai khodn dau tu.

Bén canh d6, con nhi€u cau hdi khéc gitp ta nhan dang 16p. Vi du nhu:

Ta c6 thong tin can dudc 1uu trlf hodc can dugc phan tich khong? Néu c6
thong tin can phdi dugc 1uu trlt, bi€n dGi, phan tich hodc xU 1y trong mOt phuong
thlrc ndo d6 thi chdc chan d6 sé 1a Ung cU vién cho 16p. Nhiing thong tin nay c6
th€ 12 mOt khdi ni€ém ludn can phai dugc ghi trong hé thOng hodc 1a su kién, giao
dich xdy ra tai mOt thoi di€m cu thé nao dé.

Ta c6 cdc hé thOng ngoai vi khong? N€u cé, thuOng chiing ciing ddng dugc
quan tim t&i khi tao dung md hinh. Cac hé thOng bén ngoai c6 thé dugc coi 1a cac
18p ch(ta hé thdng cla chiing ta hodc tuong tdc v&i hé thOng cla chiing ta.

Chiing ta ¢6 cdc mau, thu vién 10p, thanh phan va nhlmg th( khac khong?
Néu ching ta ¢c6 mau, thu vién, thanh phan tU cdc dU 4n trudc (xin dugc cla céc
ban dOng nghi€p, mua dugc tU cdc nha cung cap) thi chiing thuOng ciing s& chlta
céc Ung cU vién 10p.

C6 thi€t bi ngoai vi ma hé thOng cUa ching ta can xU Iy khong? MOi thiét
bi kY thuat dugc nbi v&i hé thOng cla ching ta thudng sé€ tré thanh Ung cUf vién
cho 18p xUr 1y loai thi€t bi ngoai vi nay.
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Chiing ta c6 phan cong viéc td chlc khong? Miéu td mOt don vi t6 chlc 1a
cong viéc dugc thuc hién vGi céc 18p, dac biét 1a trong cac mo hinh doanh nghiép.

TOng két vé cdc ngudn thong tin cho viéc tim 10p:

Nhin chung, cdc nguOn thong tin chinh can ddc biét chd y khi tim 16p 1a:

Céc 10i phat bi€u yéu cau

C4c TruOng hop s dung

SU tr@ gitp cUa céc chuyén gia Ung dung

Nghién c(Ctu hé thOng hién thoi

Loat cédc 16p dau tién dugc nhan dang qua diy thudng dugc goi 1a cic 18p
Ung cU vién (Candidate Class). Ngoai ra, nghién cUu nhiing hé thOng tuong tu
ciing c6 th€ s& mang 1ai cho ta cic 1Gp Ung c vién khac:

Khi nghién c(u hé thOng hién thoi, hdy d€ y dén cdc danh tUr va cic khai
ni€ém then chOt d€ nhdn ra 18p Ung cU vién. Khong nén dua cic 18p dia dugc nhan
dién mOt 1an nlfa vao mé hinh chi bdi vi ching dugc nhac 1ai & dau d6 theo mOt
tén goi khac. Vi du, mOt hé thOng nha bing c6 th€ coi cing mOt khach hang vGi
nhi€u vi tri khic nhau 14 nhi€u khich hang khic nhau. Can chd y khi phan tich
nh{ing 10i miéu ta nhu thé d€ tranh dan dén sy tring 18p trong qué trinh nhén
dién 18p.

C6 nhi€u ngudn thong tin ma nha thi€t k€ can phdi chd y t&i khi thiét k€
18p va chi khi 1am nhu vay, ta m&i c6 thé tin chac vé khd ning tao dung mt mo
hinh tOt. Hinh sau tGng k&t cdc nguOn thong tin k€ trén.

_ Use Cases sk
Requirement Application
Statement Experts
Previous B Similar
Systems g Systems

Hinh 3.4 - NguOn thong tin hO tro tim 1Op
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Céc truOng hgp st dung 13 nguOn tOt nhat cho viéc nhan dién 16p va d6i
tugng. Can nghién clu kY cic TruOng hop s dung d€ tim cidc thuQc tinh
(attribute) bdo tru@c su tOn tai cla dbi tuong hodc 18p tiém ning. Vi du néu
Trudng hop s dung yéu cau phai dua vio mOt sO tai khodn (account-number) thi
di€u nay trd tGi su tOn tai cla mOt dOi tugng tai khodn.

MOt nguOn khdc d€ nhdn ra 16p/doi tugng 1a cac Input va Output cUa hé
thOng. N€u Input bao gbm tén khach hang thi diy 12 tin hi€u cho biét su tOn tai
clla mOt dOi tuong khach hang, b3i né 12 mOt attribute cUa khach hang.

N6i chuyén véi ngudi st dung ciing ggi m& dén cic khdi niém then chot.
ThuOng thi ngudi st dung miéu td hé thOng theo 10i can phdi dua vio nhimng gi
va mong chO két qud gi. Thong tin dua vio va két qua theo 10i miéu ta cla ngudi
sUf dung can phdi dugc tap hdp 1ai v6i nhau d€ nhan dang khéi niém then chot.
1.2. Bi€u do 16p

MOt bi€u d6 18p 1a mOt dang md hinh tinh. MOt bi€u d6 16p miéu td hudng
nhin tinh cla mOt hé théng bang cic khai niém 18p va mOi quan hé gilta chiing
vOi nhau. Mdc du né ciing ¢6 nhitng nét tuong tu' véi mOt mo hinh d{r li€u, nhung
nén nhG rang cdc 18p khong phai chi th€ hién cdu triic thong tin ma con miéu ta ca
hanh vi. MOt trong cdc muc dich cUa bi€u d0 18p 12 tao nén tdng cho cic bi€u do
khéc, th€ hién céc khia canh khic cUa hé thOng (vi du nhu trang thdi cUa doi
tugng hay cong tic dOng gilra cdc dOi tugng, dugc chi ra trong cdc bi€u d6 dOng).
MOt 16p trong bi€u do 18p c6 th€ duoc thuc thi truc ti€p trong mOt ngdn nglt
huéng doi tugng c6 ho trg truc ti€p khai niém 16p. MOt bi€u do 18p chi ra céc
18p, nhung bén canh d6 con cé6 mOt bi€n tdu hoi khac mOt chiit chi ra cdc doi
tugng that su 1a cac thuc th€ cla cac 18p nay (bi€u d6 doi tugng).

PéE tao moOt bi€u d0 16p, dau tién ta phdi nhan dién va miéu td cac 16p. MOt
khi da c6 mOt sO 1ugng cic 18p, ta s€ xét dén quan hé gilta cic 16p dé véi nhau.

Cic loai 16p trong bi€u do:
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Bi€u d6 18p c6 th€ chlra nhi€u loai 18p khéac nhau, ching c6 th€ 1a nhling
[Gp thong thuOng, 10p tham sO hod, 10p hién thuc, 10p tién ich, va I0p metaclass
(siéu IOp).

LOp tham s6 hod(ParameterizedClass)

LOp tham s6 hod 1a 18p dugc s dung d€ tao ra mOt ho cic 18p khac. Trong
nh{ing ngon ng(t 1&p trinh c¢6 ki€u manh nhu C++, 18p tham s hoa chinh 13 16p
mau (template). Trong UML, c6 th€ khai bdo 13p tham sO hoa (16p mau) Set cho
ho céc 18p c6 céc phan tlr1a ki€u T bat ky, dugc xem nhur 13 tham s nhu sau:

insert(T &)
remove(T ¢)

Hinh: LOp dugc tham sO hod

LGp tham sO hod c6 thé s dung d€ th€ hién quyét dinh thi€t k€ vé cic
giao thlc trao d6i gilta cac 16p. LOp tham sO hod it dugc s dung trong md hinh
khdi niém ma chU y€&u dugc si dung trong cdc mod hinh cai dat, nhung ciing chi
khi ngén ng( 1ap trinh dugc chon d€ 1ap trinh c6 hO trg cd ché 18p mau (template
class) nhu C++ chang han. Ciing can Iuu ¥ 1a khong phai tat cd cdc ngdn nglr 1ap
trinh hudng doi tugng déu ho trg ki€u 16p mau, vi du Java khong hd trg, nhung
tat cd céc 18p trong Java 1ai tao ra cau tric ciy phan cap c6 goc 1a 18p Object. Do
tinh chat phan cap cUa ciy va nguyén 1y chung bdo toan m&i quan hé gilra cic 18p
con v&i 18p cha (nguyén 1y thanh vién va nguyén 1y 100%) ma ta van c6 thé tao ra
dugc nhitng cau tric tOng quat, khong thudn nhat tuong tu nhu 18p mau [15].

LOp hién thuc(InstantiatedClass)

LOp hién thuc 1a loai 16p tham sO hod ma d6i sO cla né 1a mOt ki€u trj cu
th€. Nhu vay, 18p tham sO hod 1a khudn d€ tao ra cac 16p hién thuc.

LGp Set<Complex> tap céac sO phlc (Complex) 1 16p hién thuc dugc bi€u
dién trong UML nhu hinh 2.
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Set <Complex>

msert(Complex ¢)
remove(Complex ¢)

Hinh: LOp hién thuc hod
LOp tién ich (Class Utility)
LOp tién ich 1a tap hgp cic thao tdc dugc st dung nhi€u noi trong hé thOng,
chiing dugc t& chUc thanh 18p tién ich d€ céc 18p khic c6 thé cling st dung. Trong
bi€u d0, 16p ti€n ich dugc thé hién bang 18p c6 dudng vién béng nhu hinh 3 (a).

MewClassUtility — )
“Dpnameﬂ Interface
a b

(a) LOp tién ich (b) Giao dién

Giao dién(Interface)

Giao dién la tap nhling thao tic quan sit dugc tU bén ngoai cla mOt 16p
vi/hodc mOt thanh phan, va khong cé ndi dung cii dat cUa riéng 18p d6. Giao dién
thuQc quan sét logic va c6 th€ xudt hién trong cd bi€u d6 18p va bi€u dd thanh
phan v4i ky hi€u d6 hoa nhu hinh 3 (b).

MetaClass(siéu 10p)

MetaClass 1a 13p d€ tao ra cac 10p khac, nghia 1a th€ hién cla né 14 18p ch(r
khong phdi 1a dOi tugng. L&p tham s6 hod chinh 12 mOt loai sidu 18p.

Bi€u d0 16p trong H& HBH

Trong s nhiing quan hé& k&t hop di phat hién & muc trén, dé nhan thay 16p
DanhMucMatHang ch(ra cic MoTaMatHang, do vay gi(ta hai 18p nay c6 quan
hé k&t nhdp. Tuong tU, trong mOi PhienBanHang c6 m0t s6 DongBanHang,
nghia 14 gi(ra hai 18p nay ciing s€ c6 quan hé két nhap. K&t hgp tat ca cic moOi
quan hé gilra cdc 18p nhu di phan tich & trén, chiing ta xay dung dudc bi€u db 16p

nhU sau:
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Ghi-nhin-hang-ban

0.1
. Pugc-mo-ta-bai b
DongBanHang 1
Chira
1..% DanhMucMatHang #—————| MoTaMatHang
1 1.*
Chnra-trong L Buge-sir-dung-trong 1
Mo-ta
#* £
1 Co 1
CuaHang . . |MatHang
Quan-ly
1 1
. 1% Cé
; *
PhienBanHang . L Bugc-quan-ly-bot
Thure-hign - :
- ) Buge-thire-hién-bot 1
roe-tra - . . .
Bll'@(‘—ldld’i—déﬂg—b@i Ghl—nh.'_m—ban—han
1 1 1
ThanhToan KhachHang NguoiBan

Hinh: Bi€u do 10p cia HBH
1.3. Stereotype cua lép

Mau rap khudn (stereotype) cUa céc 16p:

Mau rdp khuon (Stereotype) li cO ché m0 rOng cdc phdn tf cla moé hinh dé
tao ra nhitng phdn ttf méi. N6 cho phép dé dang bo sung thém cdc théng tin cho
cdc phan t& cla md hinh va nhing phan t nay dugc ddac ta trong cdc du 4n hay
trong qué trinh phét tri€n phan mém. N6 dugc st dung d€ phan loai céac 16p dbi
tuong.

Rational Rose di xiy dung mOt sO stereotype nhu <<boundary>>,
<<entity>>, <<control>>, <<interface>>, v.v., ngoai ra ching ta c6 thé dinh nghia
nh(ing loai ki€u mGi cho md hinh hé thOng.

LOp bién(EntityClass)
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LOp bién 1a 16p nam trén dudng bién cla hé thGng v4i phan thé gidi bén
ngoai. N6 c6 th€ 1a bi€u mau (form), bdo cdo (report), giao dién v6i céc thiét bi
phan cUng nhu mdy in, may doc anh (Scanner), v.v. hodc 1a giao dién v&i cc hé
thOng khac. Trong UML, 1&p bién dugc ky hiéu .

PE tim 16p bién hiy khdo sit bi€u db ca s dung, mOt tic nhan cé th€ xéc
dinh tuong Ung mOt 16p bién. Néu c6 hai tic nhan ciing kich hoat mOt ca st dung
thi chi can tao ra mOt 18p bién cho cd hai.

L&p thuc th&(ControlClass)

LGp thuc thé€ 12 18p 1uu gilr cdc thong tin ma né dugc ghi vao b0 nhd ngoai.

LGp SinhVien 13 16p thuc thé. Trong UML, 18p thuc thé dugc ky hiéu nhu
trong hinh 4 (b).

LGp thuc thé c6 th€ tim thdy trong cic ludng su ki€n va bi€u dO tuong tic.
Thong thuGng phai tao ra cic bang dit liéu trong CSDL cho moi 1&p thuc thé.
MO6i thuOc tinh cla 16p thuc thé trd thanh truOng dit liéu trong bang dit liéu.

L&p diéu khién

LOp di€u khién 12 16p 1am nhi€m vu di€éu phdi hoat dOng cUa céac 18p khic.
Thong thudng mbi ca s&t dung c6 mot 18p di€u khi€n d€ di€u khién trinh tU cic
su ki€én xdy ra trong no.

LGp di€u khi€n khong tu thuc hién cdc chlic ning nghi€p vu cla hé thOng,
nhUng chiing 1ai gUi nhi€u thong di€p cho nhlng 18p c6 lién quan, do vay con
dugc goi 1a 16p quan 1y.

Trong UML, 18p di€u khi€n dugc ky hi€u nhu trong hinh (c).

O O O

a b C
(a) LGp bién (b) LGp thuc thé€ (c) L8p di€u khién

1.4. Gé6i
D€ hi€u dugc nhlng hé thOng 16n, phlc tap cé nhi€u 18p dOi tugng,

thudng chiing ta phdi c6 cdch chia cic 16p d6 thanh mOt s& nhém dugc goi 1a goi.
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Géi 12 mOt nhém cac phan tl clla md hinh gbm cic 18p, cdc mOi quan hé va céc
g6i nhd hon. Cach t6 chlc hé thOng thanh cdc géi (hé thOng con) chinh 1a cich
phan hoach mo hinh thanh cdc don vi nhé hon d€ tri dé hi€u va dé quén 1y hon.
Gé6i dugc md td trong UML gOm tén cUa gébi, c6 thé cé cic 16p, géi nhd khic va
dugc ky hi€u nhu hinh 1.

GoiA

LopA > LopB

p— 7
GoiAl
Goi céc 18p trong UML

Khi phan chia céc 16p thanh cédc géi, ching ta ¢6 thé dua vao: céc 18p chinh
(18p thOng tri), cdc mOi quan hé chinh, cic chUc ning chinh. Theo c4ch phan chia
d6 chiing ta c6 th€ chia hé thOng thanh cic phan hé phit hop v&i cich phan chia
trong hé thOng thuc.

Hé thOng qudn 1y thu vién c6 th€ t6 chlc thanh bOn géi: géi giao di€n, géi
nghi€p vu, géi CSDL va g6i ti€n ich nhu hinh 2. Trong do,

Géi giao di€n (UI — User Interface): bao gOm céc 16p giao di€n vGi ngudi
diing, cho céc khd ning quan sit va truy nhap vao d{t li€u. C4c d0i tuQng trong géi
nay c6 th€ thuc hién céc thao tic trén cdc dOi tUgng tic nghi€p d€ truy van hay
nhap d{ liéu.

G6i nghi€p vu (Business Package): chlfa cac 18p thuc th€ thuQc linh vuc bai
todn Ung dung.

G6i CSDL: chta cic 18p dich vi cho cdc 18p G géi tac nghi€p trong viéc tO
chlc, quan Iy va luu r(r dir liéu.

Géi ti€n ich: ch(ra cc 18p dich vuU cho cic g6i khac cla hé thOng.

Céc g6i clla mOt hé thOng thudng c6 mOi quan hé v&i nhau, nhu quan hé
phu thuOc.

63



Go1 UI ~ o
I Tl
W ~~_ [1
Goinghiépvu ——————""—~ i Go1 tién ich
g c

I rad
W /,»"

Go1 CSDL -

Hinh: T& chlc cdc géi clUa hé thOng thu vién
1.5. ThuOc tinh va thao tac

LGp c6 thuOc tinh miéu ta nhitng dac di€m cla dbi tugng. Gi4 tri cla thulc
tinh thuOng 1a nhitng dang d{t li€u don gidn dugc da phan céc ngdn nglt 1ap trinh
ho tr@ nhu Integer, Boolean, Floats, Char, ...

ThuOc tinh c6 th€ c6 nhi€u mlc d0 trong thdy dugc (visibility) khac nhau,
miéu t3 li€u thubc tinh d6 c6 th€ dugc truy xudt tU cdc 18p khic, khac vdi 16p
dinh nghfa ra né. Néu thudc tinh c6 tinh trong thdy 1a cdng cOng (public), thi n6 cé
th€ dudc nhin thay va st dung ngoai 18p d6. Néu thulc tinh c6 tinh trong thdy la
riéng (private), ban s€ khong th€ truy cap né tU bén ngoai 18p d6. MOt tinh trong
thay khic 12 bdo vé (protected), dugc si dung chung v&i cong cu khai quat héa va
chuyén biét héa. N6 ciing giOng nhu c4c thulc tinh riéng nhung dugc thuz k€ béi
cdc 1Gp dan xuat.

Trong UML, thuQc tinh cong cOng mang ki hi€u "+" va thulc tinh riéng
mang dau "-".

Gi4 tri dugc gan cho thudc tinh c6 th€ 1a mOt cach d€ miéu ta trang théi cla
d0i tugng. MOi 18n cdc gid tri nay thay doi 1a bi€u hién cho thdy c6 thé da xay ra
mOt sU thay d0i trong trang thai cUla d6i tuong.

Luu y: M0i dac di€m cla mOt thuc thé 14 nhiing thong tin can luu trlr déu
c6 th€ chuy€n thanh thudc tinh cla 18p miéu ta loai thuc thé dé.
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1.6. Cac bai tap va vi du
2. Quan hé
2.1. Quan hé gitlra cac 16p

2.2. Lién két (association)

MOt lién hé 1a mOt su nOi két gilra cac 18p, mOt lién quan vé€ ng(r nghia gilra
cdc d6i tuong cla céc 16p tham gia. Lién hé thuOng thuOng mang tinh hai chiéu,
c6 nghia khi m6t d6i tuong nay c6 lién hé v4i mOt doi tugng khéc thi cd hai dbi
tugng nay nhan thdy nhau. MOt moi lién hé bi€u thi bang cic d6i tugng cla hai
18p c6 n6i két v4i nhau, vi du rang "ching bi€t vé nhau", "dugc ndi v4i nhau",
"c(r mOi X 1ai ¢6 mOt Y"..... Lép va lién hé gilra cic 18p 1a nhiing cong cu rat
manh mé cho vi€c md hinh héa cic hé thOng phUc tap, vi du nhu cau tric sdn
pham, cdu tric vin ban va tat ca cdc cau triic thdng tin khac.

M®i lién két dugc thé hién trong bi€u d6 UML bang mOt dudng thang noi
hai 16p

Tses b

Author Computer

Hinh -MOt 16p Author k&t hgp véi 18p Computer

1- Vai tro trong lién hé

MOt lién hé c6 thé c6 cdc vai trd (Roles). Cac vai trd dugc ndi vGi moi 16p
bao chlra trong quan hé. Vai trd cla mOt 16p 1a chlic ning ma né ddm nhan nhin U
g6c nhin cUa 18p kia. Tén vai trd dugc viét kem v&i mOt mii tén chi t hubng 16p
chU nhén ra, th€ hién 18p nay déng vai trdo nhu thé nao doi vGi 16p ma miii tén chi
dén.
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Holds »

Cugtﬂmﬂf Aﬂcouﬂt
4 Owned by

Hinh 4.10- Vai trd trong lién hé gilra Customer va Account

Trong vi du trén: mOt khach hang c6 th€ 1a chU nhan clUa mot tai khodn va
tai khodn dugc chi€m gilr bdi khach hang. PuOng thang th€ hién lién hé gilra hai
16p.

MOt sO di€m cén chi y khi dat tén vai tro:

Tén vai trd ¢ th€ bo di n€u trung v4i tén 18p

Tén vai trd phdi 1a duy nhat.

Tén vai trd phai khic vGi cdc thuQc tinh cla 16p.

Tén vai trd phdi miéu td dugc chlic ning ma 18p nay ddm nhan trong quan
hé, tlc can phdi 1a cic khdi niém 1ay ra tU pham vi van dé, gibng nhu tén cic
16p.

2- Lién hé mOt chi€u (Uni-Directional Association)

Ta ciing c6 thé s dung m0Oi lién hé mot chi€u bang ciach thém mOt mii tén
va mOt dau cla dudng thang n6i két. Mii tén chi ra rang su ni két chi c6 thE
duoc s dung duy nhat theo chi€u clla miii tén.

Earned from »

Interest Account

W

Hinh - Lién hé mOt chiu gilla Interest va Account
Bi€u d0 phan 4.11 th& hién rang gilta hai 19p c6 lién hé, nhung khong hé c6
thong tin v€ sO 1uong cdc dOi tugng trong quan hé. Ta khong th€ biét mot khach

hang c6 th€ c6 bao nhiéu tai khodn va mOt tai khodn cé thé€ 1a cla chung cho bao
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nhiéu khich hang. Trong UML, loai thong tin nhu thé dugc goi 1a s6 1ugng phan
tUr (Cardinality) trong quan hé.
3- SO 1ugng (Cardinality) trong lién hé:

4 Owned by

Customer Accgunt

Hinh - S6 lugng trong lién hé gilta Customer va Account

Bi€u d0 trén néi rd mOt khach hang c6 th€ m& mdt hodc nhi€u tai khodn va
mOt tai khodn c6 th€ thudc vé mot cho tdi ba khach hang.

SO lugng dugc ghi G phia ddu dudng thang th€ hién lién hé, sat vao 10p 1a
mién 4p dung cla né. Pham vi cUa s& 1ugng phan t( trong lién hé& c6 thé tlr 0-tGi-
1 (0..1), O-tGi-nhi€u (0..* hay ), mOt-t&i-nhi€u (1..), hai (2), nim-t&i-mudi mot
(5..11). Cing c6 thé miéu ta mOt day sO vi du (1,4,6, 8..12). Gid tri mac dinh 1a 1.

Documents

]__#

Generate| o

-w
Havwe

Savings Has p 1 * Saving

Acc-:-lunt Accounts
Service

4 Belong to

1_3IC

Owmned by
w

Customers

Hinh - M0t sO d0 10p tiéu biéu
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Hinh trén 13 vi du cho mOt bi€u d6 18p tiéu bi€u. Bi€u do gidi thich rang bd
phan dich vu tai khodn tiét ki€ém cla mOt nha bing c6 th€ cé nhi€u tai khodn ti€t
ki€ém nhung tat ca nhng tai khodn nay d€u thuOc v€ b0 phan dé. MOt tai khodn
ti€t kiém v€ phan né 1ai c6 th€ c6 nhiéu tai li€u, nhung nhing tai 1i€u nay chi
thuOc vé mot tai khodn ti€t kiém ma thoi. MOt tai khodn tiét kiém c6 thé thudc
vé tU 1 cho t&i nhiu nhat 1a 3 khach hang. MOi khich hang c6 th€é c6 nhi€u hon
mOt tai khodn.

4- Phat hién lién hé:

ThuOng s€ cé nhi€u moi lién hé gilta cidc dOi tuong trong mOt hé thOng.
Quyét dinh lién hé nao can phdi dugc thuc thi 1a cdng vi€c thudc giai doan thiét
k€. C6 th€ tim cac mOi lién hé qua viéc nghién ctu cic 10i phat bi€u van dé, cic
yéu cau. GiOng nhu danh tUr da gitip chiing ta tim 18p, cdc dOng tU & diy s€ gidp ta
tim ra cic mOi quan hé.

MOt vai gQi y khi tim lién hé:

Vi trf vé mat vat 1y hodc su thay thé, dai dién: MOi cum dbng tir xdc dinh
hay bi€u 10 mot vi tri d€u 12 mOt bi€u hién chac chan cho lién hé. Vi du: tai dia
diém, ngfii trong, ...

Su bao chlfa: Cum dOng tUr bi€u 10 su bao ch(ra, vi du nhu: 1a thanh phan

Giao ti€p: C6 nhi€u cum dOng tU bi€u 10 su giao ti€p, vi du truyén thong
diép, néi chuyén vdi, ...

Quyén s& hitu: Vi du: thudc vé, cla, ...

Thod man mot di€u kién: Nhiing cum tU nhu: Iam vi€c cho, 1a chOng/vgQ
cUa, quan tri, ....

5- X 1y céc lién hé khong can thiét:

Sau khi tim cdc mOi lién hé&, budc ti€p theo dé 1a phan biéc cdc lién hé can
thi€t ra khoi cdc lién hé khong can thiét. Lién hé khong can thi€t c6 thé bao gdm
nhiing lién hé bao cha cdc 16p Ung cU vién di bi loai trl hodc cdc lién hé khong
lién quan dén hé thOng. C6 nhiing lién hé dugc tao ra nham muc dich ting hiéu
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qud. Nhing lién hé nhu th€ 13 vi du tiéu ti€u cla céc chi ti€t thuc thi va khong
lién quan t&i giai doan nay.

Can chi y phan biét gilra hanh dOng va modi lién hé. Ngu0i ta thudng c6 xu
huéng miéu td hanh dOng nhu 1a lién hé, bdi ca lién hé 1an hanh dOng déu dugc
dan xudt tU nhling cum tU mang tinh dOng tU trong ban miéu tad yéu cau. Cic
hanh d0ng da dugc th€ hién sai thanh lién hé ciing can phdi dugc loai bd. Khi
lam viéc ndy, c6 thé 4p dung mOt nguyén tac: lién hé 1a ndi k€t mang tinh tinh
gilra cdc d6i tugng, trong khi hanh dOng chi 1a thao tic xay ra mOt 1an.

Hanh dOng vi vay nén dugc coi 12 Phuong thUc ddi vdi mOt doi tugng ch(r
khong phdi quan hé gilra céc 16p.

Vi du vGi "Ban quan tri nha bing dudi viéc mOt nhan vién", dOng tUr “dui
vi€c” th€ hién hanh dOng. Trong khi d6 v&i “MOt nhan vién 1am viéc cho hang" thi
dOng tU “lam vi€c" miéu ta lién hé gilra hai 18p nhan vién va hang.

Trong khi c& gang loai bo cic lién hé du thira, ban sé thdy c6 mot s6 lién
hé du thUra d3 "1€n vao" md hinh cla ching ta trong giai doan thi€t k&. Hinh sau
chi ra mOt sO loai lién hé du thUra can ddc bié€t chd trong.

All Associations

Derived Higher Order
Associations Associations
Associations
et irrpigvag

aEiihatad Associations
classes
' Implementation
Actions Associations
Required
Associations

Hinh - Loai b0 cdc lién hé khéng can thiét
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2.3. Phu thuOc va géi phu thudc

2.4. Quan hé két tap (Aggregations)
Két tap 1a mOt trudng hop ddc biét cla lién hé. K&t tap bi€u thj rang quan

hé gilta cic 10p dua trén nén tang cla nguyén tac "mot tOng thé dugc tao thanh
bGi cac bd phan". N6 dugc st dung khi ching ta muOn tao nén mot thuc thé mdi
bang céch tap hdp céc thuc thé tOn tai vOi nhau. MOt vi du tiéu biu cla két tap
12 chi€c xe 6 t6 gbm c6 bOn banh xe, mOt dOng cd, mOt khung gam, mot hdp s0,
V.v....

Qua trinh ghép cic b phan lai v&i nhau d€ tao nén thuc thé€ can thi€t dugc
g0i 1a su két tap. Trong qud trinh tim 18p, két tap s€ dugc chi y tGi khi gdp céc
loai dOng tU “dudc tao bdi", "gbm c6", .... Quan hé két tap khdng c6 tén riéng.
Tén ngam cha trong n6 13 "bao gOm céic thanh phan".

Ki hiéu két tap:

Ki hiéu UML cho k&t tap 1a dudng thang v6i hinh thoi (diamond) dat sét
18p bi€u thi su két tap (tOng thé).

MOt 16p tai khodn dudc tao bdi cic 18p chi ti€t vé khach hang, cic 1énh
giao dich d6i v4i tai khodn ciing nhu céc quy dinh cUa nha bing.

Quan hé trén c6 thé dudc trinh bay nhU sau:

Customer Operating Business
Details Instructions Eules
Quan hé két tap (1)

MOi thanh phan tao nén két tdp (tOng th€) dugc goi 1a mOt bd phén
(aggregates). MOi b0 phan vé phan né 1ai c¢6 thé dugc tao bdi cic b0 phan khic.
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Arcount

Trong truOng hgp tai khodn k€ trén, mOt trong cdc bd phén cla né 14 cac chi
ti€t vé khach hang. Cic chi tiét vé khach hang 1ai bao gdm danh sich chU tai
khodn, danh sich dia chi, cic quy dinh vé& kY han ciing nhu céc chi ti€t khac khi

m® tai khodn.
Ké&t tap va lién hé:

Khai niém két tap ndy sinh trong tinh hubng mdt thuc th€ bao gdm nhiéu
thanh phan khic nhau. Lién hé gi(ta cdc 16p mat khic 12 mOi quan hé gilra cac

thuc thé.

Quan sat hinh sau:

Customer Operating Business
Details Instructions Eules
Holder’s Address M aturity Introduction
List List Instructions Dretails
Quan hé két tap (2)
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MOt tai khodn dudgc tao bGi céc chi ti€t v€ khach hang, cdc 1€nh giao dich
doi vdi tai khodn ciing nhU cdc quy dinh cUa nha biang. Khich hang khong phai 1a
12 b0 phan cUa tai khodn, nhung c6 quan hé véi tai khodn.

Nhin chung, n€u cic 18p dugc nOi két v4i nhau mot cach chat ché qua quan
hé "toan th€ — b0 phan" thi ngUdi ta cé th€ coi quan hé 1a két tap. Khong c6 10i
huéng dan chac chan va rd rang cho viéc bao gid nén dung két tdp va bao gi® nén
dung lién hé. MOt 16i tiém can nhat quan di kem vGi nhimg ki€n thlc siu sac vé
pham vi van dé sé gitp nha phan tich chon gidi phép ding dan.

Khai quat héa va chuyén bi€t héa (Generalization & Specialization)

Hiy quan sét cdu tric 18p trong bi€u d0 sau:

Arccount
Y
r LY
7 N,
Term Based Tranzaction Bazed
= F
.r'r:r 1"-. _.r'r 1'1
“hort Term Long Term Current Savings
Account Aeccount

Chuyén biét ho4 (Specialization)

Trong hinh trén, tai khodn Ia khéi ni€m chung cUa cédc loai tai khodn khéc
nhau va ch(fa nhiing dac ta can thiét cho tat ca cdc loai tai khodn. Vi du nhu né
c6 thé chra sO tai khodn va tén chU tai khodn. Ta c6 thé cé hai loai tai khodn dac
biét suy ra tU dang tai khodn chung nay, mot loai mang tinh ky han va mot loai
mang tinh giao dich. Y&u t0 chia c4ch hai 18p nay vGi nhau 13 cdc quy dinh chuyén
nganh hay ding hon la phuong thUc hoat dOng cUa hai loai tai khodn.
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Tuong tU nhu vay, tai khodn dau tu trung han va dai han 1ai 12 nhing khéi
niém chuyén biét cla khai niém tai khodn c¢6 ky han. Mat khéc, tai khodn binh
thuOng va tai khodn ti€t ki€ém 1a nhiing truOng hgp ddc bi€t cla loai tai khodn
giao dich.

Loai cdu tric 18p nhu thé dugc goi 14 mOt cdu triic hinh ciy hodc cdu triic
phan cap. Khi chiing ta dich chuyén tUr di€m xuat phat cla cAy xuOng dudi, ching
ta s& gdp cédc khdi ni€m cang ngay cang dugc chuyén bi€t héa nhi€u hon. Theo
con duOng di tlr tai khodn dé€n tai khodn ti€t ki€m, ta s& phdi di qua 16p tai khodn
giao dich. L&p nay ti€p tuc phan loai cdc 16p chuyén biét héa cao hon, tuy thubc
vao chUc niing cUa chiing.

Ki hi€u khdi quat héa va chuyén biét hda

Trong bi€u d6 trén, cic 16p trong mOt cdu tric cdy dugdc nbi v4i nhau bang
mOt mi tén rOng , chi ti 1Gp chuyén biét hon t6i 18p khéi quat hon.

Generalized Class

AN

spectalised Class

Khéi quat hoa

Qué trinh bat ddu v&i mot 10p khdi quat d€ sdn xudt ra cic 1Gp mang tinh
chuyén biét cao hon dugc g0i la qué trinh chuyén bi€ét hoa(Specialization)

Chuyén biét héa: 13 qua trinh tinh ch€ mOt 16p thanh nhiing 18p chuyén biét
hon. Chuyén biét héa b6 sung thém chi ti€t va ddc td cho 18p két qua. Lép mang
tinh khdi quat dugc goi 1a 18p cha (superclass), k€t qud chuyén bi€t héa 1a viéc
tao ra cac 18p con (Subclass).

Mat khic, n€u chiing ta di doc cdu tric ciy tU dudi 1én, ta sé gdp céc 16p
ngay cang mang tinh khdi quét cao hon - Vi dy tU 16p tai khodn tiét ki€ém 1én t&i
18p tai khodn. Con duOng bat dau tUr mOt 18p chuyén biét va khi€n né ngay cang
mang tinh khai quat cao hon dugc goi la qua trinh khai quat héa (Generalization).
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L&p chuyén biét & diy dudgc goi 1a 16p con, trong vi du trén 14 tai khodn ti€t kiém,
trong khi 16p khdi quat k€t qud dugc goi 12 18p cha.

Chuyén biét héa va khai quat héa 13 hai con dudng khic nhau d€ xem xét
cing mOt mOi quan hé.

MOt 16p 12 16p con clia mOt 18p nay c6 th€ déng vai trdo 1a mOt 18p cha cla
16p khic.

Y&u td phan biét (Discriminatior)

P& tao mOt cau tric phan cadp, can phai c6 mOt s thudc tinh 1am nén tang
cho qud trinh chuyén biét héa. Thubc tinh d6 dugc goi 1a yéu té phan biét
(Discriminator).

VGi mOi gid tri ¢6 thé gan cho y€u td phan biét trong 13p cha, ta s€& c6 mOt
16p con tuong Ung.

Leocount

Mature of Account
F
| II"-

/ .
Term Bazed / Transaction Based
{
.-'P"-L II" _,rﬂ'\._
ry "\-_“

.-'"r "-"'- ! /
. II . . B
Duration based [ Activity based
. {

N
Digcriminatior
short Long Current Savings
Term Term Aecount Arccount

Yé&u td phan biét (Discriminatior)
Trong hinh trén, y&u tO phan bi€t trong 1&p tai khodn 13 "loai tai khodn".
Chiing ta gid thi€t rang chi c6 hai loai tai khodn, mOt mang tinh ky han va mot
mang tinh giao dich. Theo d6, ta phdi tao ra hai 18p con, mOt cho céc tai khodn

mang tinh ky han va m&t cho cdc tai khodn mang tinh giao dich.
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Trong md hinh doi tugng, khong nhat thi€t phdi néu bat y€u t0 phan biét.
Yé&u t0 phan bi€t ludn c6 mat trong mOt cdu trisc phan cap 18p cha/ con, du cé
dugc nhan manh trong mo hinh d6i tugng hay khong. Mac dau vay, d€ ddm bdo
cho m6t md hinh dugc dinh nghia 6 rang, trinh bay y€u td phan biét van ludn 1a
cong viéc nén thuc hién.

L&p trUu tUgng

Quan sit cdu tric trong hinh trén, ta thdy 16p tai khodn s€ khong bao gid
dugc thuc th€ héa, c6 nghia 1a hé thOng sé khong bao gi0d tao ra cic doi tugng
thuOc 16p nay. Nguyén nhan 12 vi 18p tai khodn mang tinh khai quét cao dé€n muUc
d0 viéc khéi tao 10p nay sé khong c6 mOt y nghia nao ding k€. Ldp tai khodn
mac dit vy van déng mot vai trd quan trong trong viéc khdi quat héa cdc thudc
tinh s& dudc can dén trong cdc 10p dan xudt tU né. Nhitng loai 15p nhu thé dugc
dung d€ cung cap moOt ciy cdu tric 10p va khong c6 su tOn tai day dU y nghia
trong mOt md hinh that sy ngoai dOi, ching dugc goi 1a 10p tritu trugng
(abstract class).

Tao 18p trUu tUong

Céc 16p tru truong 13 k€t qud cla qud trinh khéi quét héa. Hay quan sit vi
du cdu triic 18p sau diy. L3p tai khodn dUing dau ciy cdu tric va dugc goi 1a 18p
cin ban. L&p cin bdn clla mOt ciy cdu triic chlta nhiig thubc tinh da dugc khai
quét héa va cé th€ duoc dp dung cho moi 18p dan xudt tif né. Trong qud trinh khii
quat héa, cdc thubc tinh dugc dung chung trong cac 18p chuyén biét dugc dua 1én
18p cha. L3p cha vé culi dudc tao bdi cic thuQc tinh chung cla tat ca céac 18p
dan xudt t& né. Nhing 18p cha dang nhu vay trong rat nhi€u truGng hgp s€ mang
tinh khdi quat tuyét d6i va sé khong theo dudi muc dich khdi tao, ching c6 16i Ung
xU gidng nhu mOt thiing ch(ra (container) cho tat cd cac thuQc tinh chung cUa cic
18p dan xudt. Nhitng 16p nhu thé trong truOng hgp chung thuOng 12 két qud 4nh
xa cUa nhiing danh tU trUu tUgng, 1a hé quad cla phuong phdp st dung céc danh
tUr d€ nhan dién 16p .
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Aecount
Acconunt Mamber

Customer Mame
Pl

Term Baszed Trans. Based
Term Duration Mlinimuim Balance

| T | | f‘r |

Shott Term | Long Term | | Current Account |Sawings Account
Min. Amount |Loan Facilities| | Overdraft facility | Interest earned

Tao 16p trUu tUQng

Bi€u d0 trén cho ta mOt vi du vé khai quét héa va cic thulc tinh chung, né
chi ra nhi€u 18p chuyén biét. Chi y rang c( theo mOi mUc chuyén biét héa 1ai c6
thém cic thuQc tinh dugc bd sung thém cho cic 18p, khi€n chiing mang tinh chuyén
biét cao hon so v&i cdc 10p cha @ mUc trUu tugng bén trén. Vi du 18p tai khodn c6
thuOQc tinh 13 sO tai khodn va tén khich hang. Piy Ia nhlng thuOc tinh hét slc
chung chung. Tat cd cac 18p dan xudt tU né, dir 1a truc ti€p hay gidn ti€p (& céc
mUc d0 trltu tugng thap hon nlra), déu c6 quy€n st dung cic thudc tinh d6 cla
1Gp tai khodn. Céc 10p tai khodn c6 ky han va tai khodn giao dich 1a hai 18p chuyén
biét dan xudt tU 18p tai khodn. Ching c6 nhling thudc tinh chuyén biét riéng cla
chiing - vi du mUc thdi gian (duration) dGi v&i 16p tai khodn c6 ky han va mUc
tién tOi thi€u dGi v3Gi 16p tai khodn giao dich — bén canh hai thubc tinh sO tai
khodn va tén khach hang ma ching thUa k€ tU 16p tai khodn. Ciing tUong tU nhu
th€ vdi tai khodn dau tu ngdn han va tai khodn dau tU trung han 14 céc loai 16p
thuOc tai khodn c6 kY han, tai khodn ti€t kiém va tai khodn binh thudng la céc
loai 18p thuOc 18p tai khodn giao dich.

L&p cu thé& (concrete class)
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LGp cu thé€ 1a nhitng 18p c6 thé€ thuc thé héa. Nhu da néi tUr trude, cic 16p
cu thé€ khi thuc th€ héa dugc goi 1a cac doi tugng. Trong vi dU trén, cac 10p tai
khodn ddu tu ngan han va tai khodn dau tu dai han cé thé dugc thuc thé héa
thanh d0i tugng. Tuong tu dOi v&i tai khodn ti€t ki€m va tai khodn binh thuOng.

TGOng k€t vé phit tri€n ciy cau tric

CO ché ding chung thudc tinh va thd tuc st dung nguyén tac khéi quat héa
dudc goi 1a tinh thira k& (inheritance). SU dung tinh thira k€ dé€ tinh ché (refine)
cdc 10p sé dan tGi viéc phat trién mOt cdy cdu tric. Nén phat hién nhiing Ung x(
(behaviour) chung trong mOt loat 18p roi thé hién né thanh mOt 18p cha. Su khac
biét trong Ung x U cUa ciing mOt 1&p s€ dan tdi viée tao ra cic 1Gp con.

Khi phit tri€n cy cdu tric, hdy quan sit Ung x( cUa cic 18p. Trong truOng
hgp c6 mOt lién hé tOn tai t& mOt 1&p cu th€ dén tat cd cic 16p con clia mot 18p
cha, nén dich chuyén lién hé nay 1én 16p cha.

Néu tOn tai mOt lién hé gilta mOt 18p nao d6 va mOt 18p cha, hiy chuyén
biét héa va nang cao cau tric d€ x4c dinh xem li€u lién hé nay cé dudc 4p dung
cho tat ca céc 18p con cla 18p cha no hay khong. N&u c¢é thi gdn n6 vao 16p cha,
né€u khong thi dich xu0ng cho nhing 16p con phu hop.

Trong khi ti€n hanh khdi quat héa, trong tim cong vi€c 1a x4c dinh cdc Ung
xU chung trong mOt nhém nhi€u 1&p chuyén biét bac trung. Khi da xay dung dugc
mOt thU tuc hodc mot thudc tinh chung, nén ki€m tra 1ai xem ching c that su la
y€u tO chung cla tat cd cic 10p chuyén biét trong pham vi nay. Khdi quit héa
duoc 4p dung chi khi ching ta ¢c6 mOt tap hdp cac 16p dinh nghia mOt loai doi
tUong riéng biét va c6 moOt sO 1ugng 16n cic Ung x( chung. Trong tAm & day la
tao nén 16p cha chra cdc Ung xU chung do.

Khi chuyén biét héa, ta di tim cac su khdc biét trong Ung x( d€ tao céac 16p
con thich Ung. C6 nghia 13 ta xem xét mOt 16p tOn tai, ki€m tra xem c6 phdi tat cd
cdc Ung xU cla n6 déu c6 khd ning 4p dung cho moi dbi tugng. N€u khong, ta
loc ra Ung x( khong phdi ldc nao ciing can thi€t va chia truGng hop né ra thanh

céc 18p con. Trong tdm cUa chuyén biét héa 1a tao cac 18p con.
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tat ca céc 16p cha cla no.

Vi co ché thUra k€, mOt 16p con s& k€ thUra moi thuQc tinh a thU tuc cla

Hinh sau lam rd viéc tao cdu triic 18p s& dung tinh khdi quat.

—>

Employee || Customer
Mame Mame
Empno Accounttio

retlame retldame

GetEmpno || GetAccno

FPerson

Matne

GetMatne

.ﬁl‘:\

Employes Customer
Empnoa Arccountiin
GetEmpno Gethcono

Phit tri€n hé théng 16p (1)
ThuOng xdy ra trudng hop tat ca cac 16p con cling tham gia vao mOt lién hé
hodc k&t tap. Trong truOng hgp nay nén tao 1&p cha dinh nghia lién hé /két tap
d6. Hinh sau gidi thich thém di€m nay:

Customer Halds Short Term
Account
Customer Holds Savings
Account
Custotner Halds Locount
Short Term Savinzs
Lrocount Account

Phit tri€n hé thOng 16p (2)
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2.5. Khai quat héa — chuyén biét héa
Hay quan sit cau tric 18p trong bi€u do sau:

Account

Term Based Transaction Based
Short Term Long Term Current DAVINZS
Account Account

Hinh - Chuyén biét hod (Specialization)

Trong hinh trén, tai khodn 12 khai niém chung cUa cédc loai tai khodn khéc
nhau va chlfa nhiing ddc ta can thi€t cho tat ca cdc loai tai khodn. Vi du nhu né
c6 thé€ chira sO tai khodn va tén chU tai khodn. Ta c6 thé c6 hai loai tai khodn dac
biét suy ra tU dang tai khodn chung nay, mot loai mang tinh ky han va mot loai
mang tinh giao dich. Y€&u td chia cich hai 1&p nay vGi nhau I cic quy dinh chuyén
nganh hay ding hon la phuong thUc hoat dOng cUa hai loai tai khodn.

Tuong tU nhu vay, tai khodn dau tu trung han va dai han 1ai 1a nhing khéi
ni€ém chuyén biét cla khai niém tai khodn c6 ky han. Mat khéc, tai khodn binh
thuOng va tai khodn ti€t ki€ém 1a nhiing truOng hgp dac biét cla loai tai khodn
giao dich.

Loai cdu tric 18p nhu thé dugc goi 1a mOt cdu tric hinh ciy hodc cdu triic
phan cap. Khi chiing ta dich chuyén tUr di€m xudt phat cla cay xubng dudi, chiing
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ta s€ gdp cédc khdi ni€m cang ngay cang dugc chuyén bi€t héa nhi€u hon. Theo
con duOng di tlr tai khodn dé€n tai khodn ti€t ki€m, ta s& phdi di qua 16p tai khodn
giao dich. L&p nay ti€p tuc phan loai cdc 16p chuyén biét héa cao hon, tuy thubc
vao chUc niing cUa chiing.

Trong hinh trén, tai khodn 13 khai ni€ém chung cUa cédc loai tai khodn khéc
nhau va ch(fa nhiing ddc ta can thiét cho tat ca cdc loai tai khodn. Vi du nhu né
c6 thé€ chira sO tai khodn va tén chU tai khodn. Ta c6 th€ c6 hai loai tai khodn dac
biét suy ra tU dang tai khodn chung nay, mOt loai mang tinh ky han va mot loai
mang tinh giao dich. Y&u t0 chia cach hai 18p nay vGi nhau 13 cic quy dinh chuyén
nganh hay diing hon 13 phuong thlUc hoat ddng cUa hai loai tai khodn.

Tuong tU nhu vay, tai khodn dau tu trung han va dai han 1ai 12 nhing khéi
niém chuyén biét cla khai niém tai khodn c6 ky han. Mat khéc, tai khodn binh
thuOng va tai khodn ti€t ki€ém 1a nhing truOng hgp dac bi€t cla loai tai khodn
giao dich.

Loai cdu tric 18p nhu thé dudgc goi 14 mOt cdu triic hinh ciy hodc cdu triic
phan cap. Khi chiing ta dich chuyén tUr di€m xuat phat cla cAy xuOng dudi, ching
ta s& gdp cédc khdi ni€m cang ngay cang dugc chuyén bi€t héa nhi€u hon. Theo
con duOng di tlr tai khodn dé€n tai khodn ti€t ki€m, ta s& phdi di qua 16p tai khodn
giao dich. L&p nay ti€p tuc phan loai cdc 16p chuyén biét héa cao hon, tuy thubc
vao chUc niing cUa chiing.

1- Ki hiéu khdi quét héa va chuyén biét héa

Trong bi€u d6 trén, cic 16p trong mOt cdu tric cdy dugdc nbi v4i nhau bang
mOt mi tén rOng, chi tU 10p chuyén biét hon tGi 10p khai quét hon.
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(eneralised Class

& \

mpecialised Class

Hinh - Khdi qudt héa

Qud trinh bat ddu v&i mot 10p khdi quat d€ sdn xudt ra cic 1Gp mang tinh
chuyén biét cao hon dugc g0i la qua trinh chuyén biét hod (Specialization)

Chuyén biét héa: 1a qua trinh tinh ché mot 18p thanh nhiing 18p chuyén biét
hon. Chuyén biét héa b6 sung thém chi ti€t va dac ta cho 18p két qua. L&p mang
tinh khéi quat dugc goi 12 18p cha (superclass), k€t qua chuyén bi€t héa 1a viéc tao
ra cic 18p con (Subclass).

Mat khéc, n€u ching ta di doc cdu tric ciy tU dudi 1én, ta s€ gap cac 18p
ngay cang mang tinh khdi quét cao hon - Vi dy tU 16p tai khodn tiét ki€ém 1én t&i
18p tai khodn. Con dudng bat dau tU mOt 1Gp chuyén biét va khi€n né ngay cang
mang tinh khédi quat cao hOn duQc goi la qua trinh khai quét hoa (Generalization).
LGp chuyén biét & diy dugc g0i 1a 18p con, trong vi du trén 1 thi khodn tiét ki€m,
trong khi 16p khai quat k€t qud dugc goi 12 18p cha.

Chuyén bi€t héa va khdi quat héa 12 hai con duGng khic nhau d€ xem xét
cing mOt mOi quan hé.

MOt 16p 12 16p con clia mOt 18p nay c6 th€ déng vai trd 1a mOt 18p cha cla
1Gp khéc.

2- Yé&u tO phan biét (Discriminatior)

D€ tao mOt cau tric phan cap, can phai c6 mOt s thudc tinh 1am nén tang
cho qud trinh chuyén biét héa. ThuOc tinh d6 dugc goi 1a yéu td phan biét

(Discriminator).
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VGi mOi gid tri ¢6 thé gan cho yéu td phan biét trong 18p cha, ta s& c6 mOt
18p con tuong Ung.

Account
JAN
MNature of Account
| .?‘
|irl
/
Term Baszed /| Transaction Based
/
.-r"'\. lIII &

F ik
£
|II £ b 1

.-"r ll‘l'\ / ra
Duration based /Activity based
r|

|

Discriminatior
ohort Long Current D avings
Term Term Account Account

Hinh - Yéu t6 phén biét (Discriminatior)

Trong hinh trén, y€u td phan biét trong 1&p tai khodn 12 "loai tai khodn".
Chiing ta gid thi€t rang chi c6 hai loai tai khodn, mOt mang tinh ky han va mOt
mang tinh giao dich. Theo d6, ta phdi tao ra hai 18p con, mOt cho cac tai khodn
mang tinh ky han va mOt cho cdc tai khodn mang tinh giao dich.

Trong md hinh ddi tugng, khdng nhat thi€t phdi néu bat yéu t6 phan biét.
Yéu t6 phan bi€t luén c6 mat trong mbt cdu tric phin cap 18p cha/ con, du c6
dugc nhan manh trong mo hinh d6i tugng hay khong. Mac dau vay, d€ ddm bao
cho m6t md hinh dugc dinh nghia 5 rang, trinh bay yéu td phan biét van ludn 1a
cong vi€c nén thuc hién.

2.1- Lép trUu tugng

82



Quan sit cdu tric trong hinh trén, ta thdy 16p tai khodn s€& khong bao gid
dugc thuc th€ héa, c6 nghia 1a hé thOng sé khong bao gi0d tao ra cic doi tugng
thudc 18p nay. Nguyén nhan 1a vi 16p tai khodn mang tinh khai quét cao d€n mlc
d0 viéc khéi tao 10p nay s€ khong c6 mOt y nghia nao ding k€. Ldp tai khodn
mac dit vy van déng mot vai trd quan trong trong viéc khdi quat héa cdc thudc
tinh s& dudc can dén trong cdc 10p dan xudt tU né. Nhitng loai 15p nhu thé dugc
dung d€ cung cap moOt ciy cdu tric 180p va khong c6 su tOn tai day dU y nghia
trong mOt md hinh that sU' ngoai ddi, ching dugc goi 1a 10p trUu truQng (abstract
class).

2.2- Tao 18p trltu tUgng

Céc 16p trlu truong 13 két qua cla qud trinh khai quéat héa. Hiy quan sat vi
du cdu tric 16p sau diy. L&p tai khodn dlng dau ciy cau tric va dugc goi 1a 16p
cin ban. LAp cin badn cla mOt cAy cdu tric chfa nhing thuOc tinh da dugc khai
quét héa va c6 th€é dugc dp dung cho moi 18p dan xudt ti né. Trong qud trinh khi
quat héa, céc thudc tinh dugc dung chung trong céc 18p chuyén biét dugc dua 1én
18p cha. L&p cha vé cudi dugc tao bdi cic thuc tinh chung cla tat cd cic 16p
dan xudt tU né. Nhing 18p cha dang nhu vay trong rat nhi€u truGng hgp s€ mang
tinh khai quat tuyét d6i va s€ khong theo dubi muc dich khdi tao, ching c6 10i Ung
xUr gidng nhu mOt thiing ch(ra (container) cho tat cd cac thuQc tinh chung cUa cic
16p dan xudt. Nhiing 16p nhu thé trong truOng hOp chung thuOng 12 két qud dnh
xa cUa nhing danh tU trUu tUgng, 1a hé qua cUa phuong phdp sU dung cic danh
tUr d€ nhan dién 16p.
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Account

Account Number
Customer Name

F o\
& d

Term Based

Term Duration

N
fh

Trans. Based
Minimum Balance

A
£y

T

|
short Term || Long Term
Min. Armount || Loan Facilities

savings Account
Interest earned

Current Account
Orwerdraft facility

Hinh - Tao I8p trlu tUong

Bi€u d0 trén cho ta mOt vi du vé khai quét héa va cic thulc tinh chung, né
chi ra nhi€u 18p chuyén biét. Chi ¥ rang c( theo mbi mUc chuyén biét héa 1ai c6
thém cic thuQc tinh dugc bd sung thém cho céc 18p, khi€n chiing mang tinh chuyén
biét cao hon so v&i cdc 10p cha @ mUc trUu tugng bén trén. Vi du 18p tai khodn c6
thuOQc tinh 13 sO tai khodn va tén khich hang. Piy Ia nhlng thuQc tinh hét sUc
chung chung. Tat cd cic 18p dan xudt tU né, dir 12 truc ti€p hay gidn ti€p (& céc
mUc d0 trltu tugng thap hon n(ra), déu c6 quyén st dung céic thudc tinh d6 cla
16p tai khodn. Céc 18p tai khodn c6 ky han va tai khodn giao dich 1a hai 18p chuyén
biét dan xudt tU 18p tai khodn. Chiing c6 nhling thudc tinh chuyén biét riéng cla
chiing - vi du mUc thdi gian (duration) dGi v&i 16p tai khodn c6 ky han va mUc
tién tOi thi€u dGi v3Gi 16p tai khodn giao dich — bén canh hai thulc tinh sO tai
khodn va tén khach hang ma ching thUa k€ tU 16p tai khodn. Ciing tUong tU nhu
th€ vdi tai khodn dau tu ngdn han va tai khodn dau tU trung han 14 céc loai 16p
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thuOc tai khodn c6 kY han, tai khodn ti€t kiém va tai khodn binh thudng la céc
loai 18p thuOc 16p tai khodn giao dich.

2.6. Lam viéc v@i quan hé
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Chuong 5. Bi€u d0 ki€n tric vat Iy va phat sinh mi trinh
1. Bi€u d0 ki€n triic vat 1y (bi€u do thanh phan va tri€n khai)
1.1. Biéu d6 thanh phan

Bi€u d0 nay cho ta cdi nhin vat Iy cla mo hinh, ddng thGi cho thdy céc
thanh phan phan mém trong hé thOng va quan hé gilra chiing.

MOt sO do thanh phan thi dugc chla dung hay tai mUc dinh cla mo hinh
hay b&i mOt g6i. Cdi ndy c6 nghia 12 sO dO s& miéu ta nhlng thanh phan va nhling
g6i ma cdi s0 d6 dé chlra dung.

Thanh phan ma nguOn: thanh phdn ma ngubn cé y nghia vao thdi di€m dich
chuOng trinh

Thanh phan nhi phan: thudng 12 ma trinh ¢6 dugc sau khi dich thanh phan
ma nguOn.

Thanh phan kha thi: thanh phan thuc hién dugc 13 t€p chuong trinh thuc
hién dugc (cic t€p .EXE), 12 két qud cUa lién két c4c thanh phan nhi phan thanh
phan thuc hién dugc bi€u dién don vi thuc hién dudc chay trén bd xU 1y mdy

tinh.

SU dung Rational d€ thi€t ké:

Tao va hly bi€u d6 thanh phan:

Tao bi€u d6 thanh phan trong khung nhin thanh phan theo cic budc nhu
sau:

Trong Browser, nhan chudt phdi trén géi chlta component diagram.
Chon thuc don New Component Diagram.
Nhap tén cho bi€u d6 thanh phan méi.
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HUy b biéu d6 thanh phan theo cic budc sau:
Trong Browser, nhan chu0t phdi trén Component diagram.
Chon thuc don Delete.

(5 (untitled) R
(3 Use Case View ABC
73 Logical Wiew

3 Component View

H-[F

=]
™| Deployment
[#8 Model Prope  mew 3

Open Specification. ..

r] o~ [ 0

B0 sung va hly bd thanh phan:

BG sung thanh phan vao bi€u d0 theo cic budc sau:

%- Rational Rose - [{untitled} - [Component Diagram: Component View f MewDiagram]
File Edit Wiew Format Browse Report GQuery Tools Add-Ins  Window Help

D %680 & WO BBRBBBB # |« @ =

B wentnea) £
[+ 3 Use Case View ABC MNew component
+ 3 Logical Vievs =
— [ Comporsnt Wiew
[ Main o~ -
=N MewDiagranm =]
# Curbommer - Customer
(=
Choose .,
Componant icon ‘EI - -

HUy bd thanh phan khdi bi€u d6 nhu sau:
Nhan phim phdi trén thanh phan trong browser.



Nhan cdc phim Ctrl+D.

1.2. Bi€u do tri€n khai
Bi€u d0 tri€n khai chi ra kién tric vat 1y cla phan cUng ciing nhU phan

mém trong hé thOng. Ban c6 thé chi ra tUng mdy tinh cu th€ va tUng trang thiét bi
cuU thé (node) di kem su nOi két gilta chiing v&i nhau, ban ciing ¢6 th€ chi ra loai
cla cdc mOi nbi két dé. Bén trong cdc nit mang (node), cdc thanh phan thuc thi
dugc ciing nhu cdc doi tuong s€ dugc xéac dinh vi tri d€ chi ra nhing phdn mém
nao s€ dugc thuc thi tai nhling nit mang ndo. Ban ciing c¢6 th€ chi ra su phu
thudc gilra céc thanh phan.

Bi€u d0 tri€n khai chi ra hudng nhin tri€n khai, miéu ta ki€n tric vat 1y that
su' cUa hé thOng. Piy 12 mOt hudng nhin rat xa 16i miéu td duy chlc ning cla
hudng nhin Use case. Mac du vy, trong mOt mo hinh tOt, ngudi ta c6 th€ chi tat
cd nhlg con dudng dan t&r mOt nit mang trong mot ki€n tric vat 1y cho tbi
nh{ing thanh phan cla né, cho t&i 16p ma né thuc thi, cho t&i nhitng tUong tic ma
cdc dBi tugng cla 18p nay tham gia d€ roi culi clng, ti€n tGi mOt Use case. Rat
nhi€éu hudng nhin khic nhau cla hé thdng dugc st dung dOng thdi d€ tao ra mot
10i miéu ta thau ddo d6i v&i hé thOng trong su tEng th€ cla no.

Clientd
Compag
Pro PC \\EJCPHP"
. | Application Datahase
! BETVEL “DecMet” | Server
P Sihn_::nn AT
| Graphies 02
-
-
. ~
E -
—gﬁzﬁf ~“TCPIP
Pro PC

Hinh - MOt bi€u d0 tri€n khai chi ra ki€n tric vat 1y cla hé thOng

1.3. Lam vi€c v6i hudng nhin Components va Deployments
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2. Phat sinh ma trinh trong Rose

2.1. Sau budc co ban d€ phat sinh mé trinh bang Rose
C6 sau buGc cd ban thuc hién d€ phat sinh ma chuong trinh:

1. Thiét 1ap céc thuQc tinh clla mo hinh

2. Ki€m tra m6 hinh

3. Tao 1ap cic thanh phan

4. Gan céc 18p vao thanh phan

5. Chon 16p, thanh phan hay géi d€ phat sinh ma.

6. Phat sinh ma chuOng trinh.

Khong phdi ngdn nglt ndo ciing can day dU cac budc néu trén. Vi du, khi
phét sinh ma chuong trinh bang C++ (hay Java) cho cdc 10p da dudc thi€t k€ chi
ti€t thi chi can thuc hién budc 5 va 6, hay budc moOt ciing khong bat budc phai
thuc hién. Tuy nhién, v& mat qui trinh cong nghi€p nén thuc hién ca siu budc
trén.

Budc 1: Thi€t 1ap cac dac tinh cia mé hinh

C6 nhi€u dac tinh dugc st dung d€ phat sinh ma ngudn c6 th€ gan cho 16p,
vai tro(Role), thuOc tinh, ham va c4c thanh phan khéc cla 16p.

+ Céc dac tinh cUa 16p bao gOm: céc todn t0 tao 1ap, huy tl, todn tl tao 1ap
nhan ban, phép dOi sanh, cdc phudng thlc truy cap d{ liéu (get/set methods)

+ Céc dac tinh cUa vai trdo bao gdm: thiét 1ap cdc phuong thUc truy cap, 18p
ch(ra.

+ Cdc dac tinh clUa phuong thlUc bao gdm: nhitng phép todn chung nhu
phuong thlc abstract, virtual, static, friend, v.v.

Cic ddc tinh nay di€u khi€n viéc phat sinh ma chuong trinh ty dOng.

Ddc tinh GenrateGetOperation trong C++ s& di€u khi€n d€ sinh mi cdc ham
c6 ti€p dau nglr 1a getX d€ doc dr liéu bi che gidu (khai bdo private) trong 18p
n€u né dugc chon. Trudc khi phat sinh mi chuong trinh nén xem xét cdc ddc tinh
cUa md hinh va c6 th€ b0 sung, hay thay d6i ching n€u can.
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PE quan sit dac tinh cla md hinh c6 thé chon Tools > Options (hodc nhén
diip vao Model Properties tU Browser), sau d6 chon ngdn ng(r 1ap trinh, vi du chon
C++ nhU hinh 1.

C6 thé€ thay d6i Value va Source cUa cic ddc tinh bang nhén chubt vio
nh{ing ddc tinh can thay dGi va lua chon céc dai lugng tuong Ung trong thuc don
day xulng.

Tap dac tinh tam thoi: thay vi nhitng ddc tinh mdc dinh, ta c6 thé€ tao 1ap
ddc tinh tam thoi d€ st dung. PE tao 1ap tap dac tinh tam thdi cho C++, c6 thé
chOn

Tools > Model Properties > Edit > C++ tab > Edit Set

sau d6 nhdn niit Close trong cUta s6 Clone the Property Set va nhdp tén mdi
cho tap ddc tinh d6. Khi khong con can dén tap ddc tinh tam thoi thi c6 thé chon

Remove dé loai bo né.
(M Uptions X

General I Diagram I Brnwserl Motation I Toolbars I ARSI E++| .&daBEl Adads
CORBA | Java | Oracled | COM | Visual Basic | XML DTD  C++ | MSvC
Type: Il:lass j
Set: Idefault j Clone |
todel Properties ﬂl
* | tame | Walue | Source -
LCodeMame Default
ImplementationT ype Default
Clazzk.ey clazz Default
GenerateE mptyRegior Al Default
PutBodieslnSpec Falze Default
GenerateDefaultCong DeclaretndDefine Default
DefaultConstructaryizsi Public Drefault
InlineDefaultConstuct False Default
ExplicitD efaultConztiy Falze Drefault
GenerateCopyCongtru DeclarsdndDefine Default
CopyConstructorizibil Public Default
InfineCopyCongtuctor Falze Default b
E=plicitCopyCaonstruch Falze Default
GenerateDestructor True Default
Drestructaryizsibilibg Public Default
Destuctorkind Common Default
InlineD estructor False Default
GeneratedzsignmentC DeclarsdndDefine Default
Azzignmentizibility  Public Default
Agzignmenttind Commaon Default
InlinedzsignmentJper. Falze Drefault
GenerateE qualiyOper DeclaredndDefing Default
E qualitytizibility Public Drefault
E qualityk.ind Commaon Default
IrlineE qualityOperation Falze Default LI
Fevert |

Hinh: Cdc dac tinh cla mé hinh d€ sinh ma cho 10p trong C++
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Budc 2: Ki€m tra mé hinh

ChUc ning Check Model & Tools dugc thi€t k€ d€ ki€m tra sU' nhat quin
gilfa cdc don th€ khi mo hinh cUa ban dugc Iuu tranh nhi€u don vi di€u khién.
Ki€m tra m6 hinh d€ phat hién nhig sai pham, nhiing di€m khong thOng nhat va
cdc 10i trong mé hinh. Sau khi chon Tools > Check Model, 16i clla mé hinh s& dugc
hié€n thi G clra s6 Log. Céc 10i hay xay ra 1a cdc thong diép trong bi€u db tuong
tdc khong dugc anh xa thanh cdc phuong thlc cla 18p tuong Ung. Muc Access
Violation s€& tim ra nhitng vi pham khi ¢6 nhltng quan hé gi(ta hai 16p & hai géi
khéc nhau, nhUng hai g6i d6 1ai khong c¢6 quan hé v6i nhau. Chon Report > Show
Access Violation d€ biét dugc nhitng vi pham dé.

Budc 3: Tao 1ap thanh phan hay m& bi€u do thanh phan

Ta c6 th€ sinh ma trinh cho tUng 1&p hodc cho tlng thanh phan chlta mOt s
18p nhét dinh va cdc mau r@p khudn (stereotype). Cdc thanh phdn can thiét d€ dnh
xa cdc 10p trong moé hinh sang ngon ng(r 18p trinh dd xdc dinh va cdc don thé€ phdn
mém. C6 nhi€u loai thanh phdn nhU thanh phdn chla mad ngubn, tép thuc thi
(.exe), t€p thu vién, v.v. Cic 18p va céc giao di€n phdi dugc gin vao mOt thanh
phan cla moét nglr cai dathodc dugc gan vao mOt sO thanh phan cla cing mOt
ngon ng(l.

3.1 Tao lap thanh phan méi

1. Chon Component view & viing Browser (thuOng hi€n thi 3 bén trai nhat).

2. Nhan chudt phdi d€ hién thi thuc don tat (shortcut). Chon New >
Package hodc New > Component r0i dat tén cho chiing, n€u khong ching s& dugc
dat tén mac dinh. Ban chon package n€u muOn tao 1ap mot géi mGi ch(ra mOt sO
18p d€ phat sinh ma chuong trinh.

3. Hodc nhdn chudt phai d€ m& thuc don tat va nhdn ddp chubt d€ md
Open Specification. Trong d6 ban c6 thé chon mau rép khudn cho thanh phan
trong Stereotype va gan ngoén ng(t cho thanh phan & hOp Language (xem hinh 2).
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BN component Specification for NewCol 2=l

General | Detail | Neslizes | s |

M ame: I MewComponent2

Sterectype: |[EETIRT= =01 Language: |C++ vl

Package Body
Package Specificatian ;I
Subprogram Body

Subprogram S pecification

Task Body |
T ask Specification et

&l
Ok I Cancel | Apply I ﬁrowsevl Help I

Hinh: Tao 18p thanh phdn mGi PE€ tao ra header file thi chOn Package
Specification, con néu mudn tao ra tép ndi dung thi chon Package Body O
Stereotype.

3.2 M@ bi€u d0 va tao lap cac thanh phan

DE tao 1ap céc thanh phan trong bi€u d6 thanh phan ching ta lam nhu sau:

1. MG Component Diagram

2. SU dung bi€u tugng Component trong thanh cdng cU d€ bG sung nhimng
loai thanh phan m&i vao biu do.

Budc 4: Gan 16p, giao di€n vao cho thanh phan

MO6i thanh phdn ma nguOn bi€u dién tép mi ngubn cla mOt hay mot vai
18p. Trong C++, mOi 16p dugc gan vao hai thanh phan ma ngudn: tép header .1 va
t€p chlra than cUla 18p .cpp. Vi C++, Rose c6 th€ khong qua budc nay, khi phat
sinh mi chuong trinh cho m&t 18p né c6 th€ yéu cau gan truc ti€p vao thanh phan
lua chOn.

MOt 16p hodc giao dién cé th€ duoc gdn vao thanh phén cUa ngon nglr 18p
trinh hodc gan vao mOt sO thanh phan cla cliing mOt ngén ngl nhu sau:

1. Chon 18p & Browser, hodc @ bi€u d0, va m& Open Specification cla 18p
do.

2. O muc Components tab, chOn Show All Components.

3. Nhan chult phai & thanh phan tuong Ung va kich vio Assign d€ gan 18p
da chon vao thanh phan dé.
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Ciing c6 th€ chon thanh phan & Browser di chudt d€ kéo né dén 18p tuong
Ung & mOt bi€u d0 & Browser, hodc m& Components tab ¢ phan ddc ta 16p (Class
Specification). Sau khi 18p dugc gan vio cho thanh phan thi & Browser, tén cUa 18p
da dugc dinh vdi tén cUa thanh phan & trong ngodc don.

DE gin nhi€u 16p (giao dién) vao mOt thanh phan ta lam nhu sau:

1. Chon thanh phan & Browser, hodc & bi€u d6 thanh phan, va md Open
Specification cUa thanh phan dé.

2. V€ Realizes tab, kich vao muc Show All Classes.

3. b6i v6i nhimg 16p can gén vao thanh phan nay thi nhan chubt phdi vao
18p d6 va kich vao Assign d€ gan né vao thanh phan di chon.

4. V& muc General tab, c6 th€ dat tén mdi cho thanh phan & hOp Name,
chon ki€u cho thanh phan d6 & hOp Stereotype, va gan ngdn ngll cai dat cho thanh
phan nay & hOp Language.

Tuong tU nhU trén, ciing c¢6 th€ chon tUng 18p (giao dién) va di chubt dé
gan nhitng 18p di chon t&i thanh phan tuong Ung trong bi€u d6 hodc G Browser.

P& gan mOt ngdn nglt cho mot 1&p (tuong tu d0i vGi thanh phan):

1. M3 phan ddc td Open Specification cUa 16p (nhan chult phdi & tén 16p).

2. V& muc Components tab, kich vio muc Show All Components. o) truOng
Language hi€n thi ngdn ng(t da dudc gan cho thanh phéan.

3. Nhan chut phdi & thanh phdn ma ban dinh gan 16p vao va nhan Assign.

P& tim xem ngdn ng(F ndo dUgc gan cho mOt 16p ta thuc hién nhU sau:

1. M3 phan ddc td Open Specification cUa 16p (nhan chult phdi & tén 16p).

2. S& nhin thdy ngdn ng( 1ap trinh di dudgc gin cho 18p d6 & trudng
Language khi chon muc Component.

Budc 5: Chon 18p, thanh phan hay géi

Ban c6 th€ chon 18p, thanh phan hay géi & Browser d€ phét sinh ma chuong
trinh dOng thOi. Néu phét sinh ma chuong trinh tU géi 6 Logical View & bi€u do
18p hay bi€u d0 thanh phan & Component View.

Budc 6: Phat sinh ma chuong trinh
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Né€u cai dat Rose Enterprise, ban c6 thé 1ua chon khd nhi€u ngdn nglr d€ cai
dat chuong trinh. PE hién thi hay 8n cdc 1ua chon ngon nglr, hiy chon Add-Ins >
Add-In Manager

Khi chon 1&p hay thanh phdn d€ phit sinh mé, hiy chon ngon nglt tuong
Ung trong thuc don trén.

PE sinh ma chuong trinh cho mét 18p hay thanh phan cé th€ thuc hién theo
hai cach.

C4ch th(r nhat thuc hién nhu sau:

1. Chon 16p, thanh phan, hay g6i G bi€u d6 hodc G Browser.

2. TU Tools chon ngdn nglt 1ap trinh, vi du C++ rdi nhan Code Generation.
MO6i 18p s€ tao ra hai t&p tuong Ung nhu d néi & trén. Khi ban mu6n xem ma
chuong trinh thi chon 18p tuong Ung, nhan chult phai, v€ C++ rOi nhan Browse
Header hodc Browse Body tuy ban muOn hi€n thi header file hay than cUa 1Gp.

Céch th( hai thuc hién nhu sau:

1. Chon 16p, hay thanh phan & bi€u do hodc & Browser.

2. Nhan chudt phdi G 18p, thanh phan da chon, va chon ngdn nglt (C++) roi
nhan Code Generation.

Néu c6 10i (Errors) hay cdnh bdo (Warning) trong qud trinh sinh ma thi
nh{ing 101, hay canh bdo d6 s& hién thi & clra s6 Log.

Ban ciing c6 th€ sinh mi chuong trinh cho 16p hodc thanh phan ma khong
can phadi thuc hién nhling budc néu trén.

PE sinh mi chuong trinh truc ti€p ta thuc hi€n nhu sau:

1. Trudc tién chon 18p (thanh phan) & biu do.

2. TU Tools, chon ngdn ngt, vi du C++.

3. Chon Code Generation d€ phét sinh ma chuong trinh bang C++ cho 18p da
chon.

Né€u chon Java thi truGc khi phdt sinh ma chuong trinh, ban phdi chon thu
muc va céc 10p tuong Ung rdi nhdn Map d€ anh xa nhiing chuong trinh dugc phat
sinh vao thU muc da chon nhu hinh dudi.
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MewClass?

4 Component Mapping x|

One or more packages or component: could not be located in any of the CLASSPATH entries.

Select a CLASSPATH entry: Select one or more pkgs 4 comps:
c:Aidk1. 34k MNewClazs? java

Fdap

And click
the Map
buttan to
implement.

Selzct Al |

Hinh: Phdt sinh ma bang Java cho 16p NewClass7
Cai gi duogc phat sinh?
Khi phat sinh ma chuong trinh, Rose tap hOp céc thong tin tU Logical View

va
Component View. Rose chi phat sinh khung chuong trinh bao gOm.
Class: mOi 10p trong md hinh d€u c6 thé dugc phat sinh ma chuong trinh,
Attribute: thuQc tinh dugc xdc dinh mién tic dOng, ki€u d{t liéu va gid tri
mac dinh,

Operation: céc thao tic dugc khai bao kem theo danh sich cic tham s0, ki€u
cUa tham s0, kiu d{r liéu tra lai,

Relationships: mOt s6 mOi quan hé s& dugc phat sinh mi tuong Ung,

Component: mOi thanh phan s& dugc cai dat trong mOt tép ma nguOn tUong
Ung.

Rose khong hudng vao thiét k€ giao di€n do hoa. Do vay, sau khi phat sinh
khung chuong trinh nhu trén, nhi€m vu ti€p theo cla ngUdi phat tri€n 13 tap hop
nhig t€p ngubn da dudc tao 1ap, 1ap trinh chi ti€t cho nhiing thao tic cla 18p
chua dugc sinh ma va thi€t k€ giao di€n d0 hoa cho hé thOng Ung dung.
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2.2. Phat sinh ma trinh C++

2.3.Vidu
Hiy cho bi€t nhitng ménh dé sau ding hay sai (true / false), gidi thich tai

sao?

+ Kién tric vat ly th€ hién cic 180p d0i tuong, cic quan hé va su cOng tac
d€ hinh thanh chUc ning cla hé thOng.

+ Kién tric phG bi€n chung hién nay cho cic hé thOng phdn mém la kién
triic ba tang: tang giao di€n, tang tic nghiép va tang luu trl.

+ Bi€u d0 thanh phdn md td cic thanh phan va su phu thubc cla ching
trong hé thOng.

+ C6 th€ chon mo hinh dif liéu quan hé d€ luu tr(r d{t liéu cho hé thOng
dugc phan tich, thi€t k& hudng doi tuong.

+ Tat cd cdc tén goi, bi€n va ki€u d{f liéu cUa cic 18p trong bi€u do 18p
dugc thi€t k€ phdi dugc chuyén tuong Ung sang ma chuong trinh trong cdc dinh
nghia 18p & ngdn ng(r 1ap trinh da dugc 1ua chon.

Xay dung bi€u d6 thanh phan cho hé thdng “Ping ky mon hoc”.

Xay dung bi€u d6 thanh phan cho hé thdng “Qudn ly thu vién”

Thuc hién sinh mi tu dOng trong Rose cho c4c 18p & hinh 7.8.

Chon tUr danh sach dudi day nhing thuét ng(r thich hgp d€ dién vao cic chd
[(...)] trong doan vin md t& v€ kién triic cUa hé thOng phan mém.

Kién tric phén mém 12 [(1)] vé cic hé th6ng con, [(2)] va [(3)] gilra ching.
Céc hé thOng con va [(2)] dugc xdc dinh theo nhi€u géc nhin khac nhau dé€ chi ra
cac

[(4)] va cUa hé thOng phdn mém. Kién tric hé thOdng dugc chia thanh hai
loai:logic va vat ly.

Chon cau tra 10i:

a. thuQc tinh chUc ning .

b. mOi quan hé.

c. cac thanh phan.

d. mOt md t3.
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e. phi chlc ning

Chon tUr danh sach dudi day nhitng thuét ng(r thich hgp d€ dién vao cic chd
[(...)] trong doan vin md ta vé biéu do6 thanh phén.

Bi€u d6 thanh phan dugc xem nhu 1a tdp cic bi€u tugng thanh phan bi€u
dién cho céc [(1)] vat Iy trong mOt [(2)]. Y tudng cO ban cla biéu d6 [(1)] 1a tao
ra cho nhing [(3)] va phat trién mOt blc tranh chung v€ cic thanh phan cla [(2)].

Chon cau trd 10i:

a. hé thOng.

b. ngu0i thi€t ké.

c. thanh phan vat 1y.

d. mOt md t3.

3. Tham khdo: tham khdo vi du 4p dung
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